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"EXPLORETO INVENT

CMR COLLEGE OF ENGINEERING & TECHNOLOGY

(AUTONOMOUS)
NAAC Accredited Institution with ‘A’ Grade

Kandlakoya (V), Medchal Road, Hyderabad -501401.

CMRCET/PRIN/NaipunyaClub/2017-18/01.

constituted with the following Members for the A.Y 2017-18.

Committee will work in line to meet these objectives
1.

OFFICE ORDER
(Sub: Re Constitution of Naipunya Club)

Date: 10™ April, 2017

With reference to the office order “CMRCET/PRIN/21/2014 dated 15" April 2014”, Naipunya Club is

w bk wbd

6.

S.No. Name of the Faculty Designation Dept. Position

1 Dr. V A Narayana Principal Chairman

2 Dr. J. SrinivasaRao Associate Professor, CE Convener

3 B. Anuradha Assistant Professor, CSE Member

4 K.Ravikiran Assistant Professor,ECE Member

5 D.S.Sanjeev Assistant Professor,EEE Member

6 K.P.V Krishna Varma Assistant Professor, ME Member

7 V. Ravindra Assistant Professor,CE Member

8 PasamRajeswari 14H51A05A0, CSE Student Member
9 - | ChSwetha 14H51A04C8, ECE Student Member
10 BandariNikhila 14H51A0264, EEE Student Member
11 P Vijay SaiGoud 14H51A0340, ME Student Member
12 MamidiArvind Reddy 14H51A0133, CE Student Member

To improve the employable skill set of the unemployed people through training.
To increase the potential of an unemployed person to set up his own workshop/small scale enterprise.
To impart practical exposure and knowledge to the school children.
To expose the school children to the usage of online learning tools and software.
To unite student members of the Naipunya club in the bonds of friendship, good fellowship and mutual

understanding.

To create and foster a spirit of oneness among the student and staff members of Naipunya club.

The committee shall meet as frequently as necessary to allow it to discharge its duties and in any case at least two times

per academic year.

Copy Submitted to: (1)

051 )

to:

(1) Deans.

(2) Vice Principal

(3) IQAC

(4) All Head’s / in charges.

(5) Controller of Examinations

(6) Administrative Officer.
(7) Accounts Officer,
(8) Office Copy.

The Secretary garu (for kind information please).
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.;Qg, CMR COLLEGE OF ENGINEERING & TECHNOLOGY

(Autonomous)
EXPLORETO INVENT NAAC Accredited Institution with ‘A’ Grade
Kandlakoya (V), Medchal Road, Hyderabad -501401.

Date: 03 May2017
MINUTES OF MEETING - NAIPUNYA CLUB

Naipunya Club meeting was held on 03-05-2017 at 02:00 PM in CMR College of
Engineering & Technology. (Room Number:102, Block I).

The chairman Major Dr. V A Narayana welcomed all the committee members.

Following are the points discussed and framed.
1. The discussions held with the sarpanches and authorities of nearby villages were

represented by the committee members
2. Based on the discussions the feasible activities are planned as follows:

Activities to be conducted for unemployed people

S. No Name of the Event/Activity Date Venue
| Hands on exposure on CNC 15-7-2017 to |CMR College of
Turning Machine 17-7-2017  |Engineering & Technology
Train.in.g sessiop on Ge.n'erai 19-8-2017 to |CMR College of
2 |Repairing of Air Condition 21-8-2017 |Engineering & Technology

System- 3 days course
3 day training on House wiring 9-9-2017 to |CMR College of

" and repairing 11-9-2017  |Engineering & Technology
4 3 day training program on 14-10-2017 to |CMR College of
welding 16-10-2017 |Engineering & Technology

Activities to be conducted for school students

S. No Name of the Event/Activity Date Venue
Briefing session on Introduction
-7- ZPHS, M bad
1 to MS - Word 22-7-2017 uneera

2 Guest lec‘ture on [ntro.duction to 26-8-2017 |ZPHS, Ravalkole
PowerPoint Presentation

Briefing session on Introduction Upper Primary School,
3-2-2018 :
to Computers Rajbollaram

4 |Guest lecture on Magnetism and 3-3-2018 |ZPHS, Pudur
Faraday’s laws
Awareness on electrical motors Upper Primary School,

7 and machines 1208 Yellampet

Briefing session on "Preparation
p

) 24-3-2018 |ZPHS, Pudur
of chemical compounds"




Resolution: All the committee members agreed to the suggestions and accepted the proposal
with enthusiasm for the events to be conducted for unemployed people and school children and
took the decision to conduct all the above events in the Academic year 2017-18.

The meeting concluded with the Chairman of Naipunya Club thanking the committee members
for their valuable suggestions.

Members Present:

D?(;. Name of the Faculty | Designation & Dept. Position Signature .
I | Major Dr.V A Narayana Principa,CMRCET | Chairman -\/'/
2 | Dr. J. Srinivasa Rao Professor, CE Convener z{l}-—
3 | B. Anuradha Asst. Prof., CSE Faculty Member | patd
4 [ K.Ravi kiran Asst. Prof.,, ECE Faculty Member &g»
5 | D.S.Sanjeev Asst. Prof., EEE Faculty Member %/
6 | K.P.V Krishna Varma Asst. Prof., ME Faculty Member Wf’%
7 | V. Ravindra Asst. Prof,, CE Faculty Member Mz‘
8 | Pasam Rajeswari 14H51A05A0, CSE | Student Member W
9 | Ch Swetha 14H51A04C8, ECE | Student Member C@*}“‘
10 | Bandari Nikhila 14H51A0264, EEE Student Member MV i
L1 | P Vijay Sai Goud 14H51A0340, ME Student Member M
12 [ Mamidi Arvind Reddy 14H51A0133, CE Student Member WM‘M

Dr. J.Srini¥a
Convener-Naij a Club Principal
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CMR COLLEGE OF ENGINEERING & TECHNOLOGY

Kandlakoya (V), Medchal Road, Hyderabad -501401

Strategic Perspective Plan for the Academic Year 2017-18

SL. | Date of the | Dept./Com | Name of the Details
No. Event mittee Event
This session is to train the unemployed
youth of nearby rural communities, to
tand help them in starting their own
ands on Ty .
. workshop or to get a job in industries.
I 15-7-2017 to [Naipunya  |exposure on e bk Sois
17-7-2017 el CNC Turni " o .
e b Mac(::hinl::mmg This session focuses trains to use the
CNC turning machine with the help of
computers to do the operations like
Threading, grooving and tapering.
B. Tech students will give the guest
talk on MS Word to the students of
i Briefing session | ZPHS Muneerabad .
2 |-229:2017 Clug’ Y |on Introduction
to MS - Word | This talk will give the details of the MS
Word along with its importance,
flexibility and application.
This session is to train the unemployed
o ) youth of nearby rural communities, to
Tra(l}mng S?SSIOH install and repair the Air condition
on Genera ! : .
: ; .| system to help them in starting their
3 i2-5-culz 1o prmpunys FRAIGg G AdF ofvn firm or top etajob in industgries
21-8-2017 flub Condition B ‘
System- 3 d g . : ]
cgurz:l e This  session focuses on basic
introduction part of AC along with its
installation, servicing and maintenance.
B. Tech students will give the guest
Guest lecture on | talk on MS Powerpoint to the students
4 26-8-2017 Naipunya Introduction to | of ZPHS, Ravalkole.
club PowerPoint This talk will give the details of the MS
Presentation Power point along with its importance,
flexibility and its application.
Its a hands-on session gn House wiring
. and repairing to train'the unemployed
9-9-2017 to |Naipunya 3 day tralnmg youth of near ral communiities,
5 on House wiring ; S T
11-9-2017 fclub Y which may fielp thenvincstarting their
and repairing \&\g L i B
own work to'get.ajob in
industries ¢ P L L
NE NV OV
14-10-2017 3 day training | It i on welding ¢
-10- Nai ay training sa Ss0n Session on welding to
6 to r‘afpu.nya program on train the@inemBloved vonth of nearhy
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them in starting their own workshop or
to get a job in industries.

Briefing session

Students of Upper Primary School,

7 3.2-2018 Naipunya ot Totraduntion Rajbollaram will be given some _
club knowledge about the computer and its
to Computers e
applications
B. Tech students will give the Guest
lecture on Magnetism and Faradays
Naipunya Guest lecture on | laws to the students of ZPHS, Pudur.
8 3-3-2018 - lub Magnetism and | This lecture will give the details of the
Faraday’s laws | MS Power point along with its
importance, flexibility and its
application.
B. Tech students will give the
awareness session on electrical motors
i to the students of Upper Primary
Nai Wareness on | gchool, Yellampet.
5 17-3-2018 Clignunya electrical motors | ;
and machines | Thjs session aims to create awareness
on electrical motors with the help of
some animations and videos.
B. Tech students will give the Briefing
Briefing session | session to the students of ZPHS
Naipunya  |on "Preparation | Pudur.This talk will give the details of
10 24-3-2018 - : . : :
club of chemical preparation of different chemical
compounds" compounds and its usage in our regular

lite..
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CMR COLLEGE OF ENGINEERING & TECHNOLOGY

(Autonomous)
NAAC Accredited Institution with ‘A’ Grade
Kandlakoya (V), Medchal Road, Hyderabad -501401.

a0
CMR

Date: 12 May 2017

To,

The Coordinator,

IQAC,

CMR College of Engineering & Technology.

Respected sir,
Sub: Request to approve the events to be conducted under Naipunya club for A.Y:2017-18.

As per the discussions held earlier with the Sarpanches of the nearby villages and the
Minutes of meeting of Naipunya Club held on 03-05-2017at 02:00 PM in CMR College of
Engineering & Technology.(Room number: 102, Block I), all the committee members passed a
resolution to conduct the below mentioned events under Naipunya club for the Academic Year

2017-18.

Hence I request you to kindly approve the events to be conducted and also to facilitate us

with the resources for the successful completion of the events under Naipunya Club.

S. No Name of the Event/Activity Date Venue
| Hands on exposure on CNC Turning 15-7-2017 to  |CMR College of Engineering &
Machine 17-7-2017 Technology
’ ar;eflagoi;ssion on Introduction to 2272017 ZPUS. Mirsenibad
5 Training session on General Repairing 19-8-2017 to  |CMR College of Engineering &
of Air Condition System- 3 days course 21-8-2017 Technology
i Guest lec'ture on Intro_ductlon to 26-8-2017 ZPHS, Ravalkole
PowerPoint Presentation
5 3 day training on House wiring and 9-9-2017to  |CMR College of Engineering &
repairing 11-9-2017 Technology
£ AR i (i 14-10-2017 to |CMR College of Engineering &
ay training program on welding 16-]0-2017 Technology
7 Briefing session on Introduction to 3.2.2018 Upper Primary School, Rajbollaram
Computers
8 Guest lecture on Magnetism and Faradays 3.3.2018 ZPHS. [y/
laws
¢ AW cH
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9 2\:;:?:&55 on electrical motors and 17-3-2018 Upper Primary School, Yellampet
ines
10 Briefing gession on "Pre;:aration 24-3-2018 ZPHS, Pudur
of chemical compounds
Thanking you,
Yours sincerely
Vol A

M (% oV ¢ Dr. J. Srinivasa Rao

/0_\( o bxg(/\_______, Convener- Naipunya Club
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(AUTONOMOUS)

oAV NAAC Accredited Institution with ‘A’ Grade
BT Kandlakoya (V), Medchal Road, Hyderabad -501401.

CMR COLLEGE OF ENGINEERING & TECHNOLOGY

To
The Principal,

CMR College of Engineering & Technology,

Hyderabad.

Through: Coordinator, IQAC- CMRCET.

Respected sir,

Date: 05-07-2017

Subject: Permission for organizing hands on exposure on CNC Turning Machine — Reg.

As per the discussion held with surpanches of nearby villages, Naipunya Club is planning
to organize a hands on exposure on CNC Turning Machine to the unemployed youth of nearby five
villages from 15-07-2017 to 17-07-2017 in our campus.

The main objective of this training is to focus on training the unemployed people towards
increase in their chance of employment. :

Resource person for this training is Mr. D. Ajay, Associate Professor of department of

Mechanical Engineering.

Kindly accept the proposal and provide the resources.

The Schedule is enclosed.
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Schedule:

Day 1

TIME

TOPICS

10:00am-11:30am

Introduction to CNC Lathe Machine

11:30am — 11:45am
Break

11:45am - 1:15Pm

[ Types to CNC Lathe Machine

1:15pm - 2:00pm
Lunch

2:00pm —4:00pm

| Lathe Mechanisms

Day 2

10:00am — 11:30am

| Lathe Applications

11:30am - 11:45am
Break

11:45am - 1:15pm

| Lab Visit: Briefing of Lathe machines

1:15pm - 2:00pm
Lunch

2:00pm — 4:00pm

| Basic Working on Lathe Machine

Day 3

9:00am — 1:00pm

| Operating Lathe for Different Operations

1:00pm - 1:30pm
Lunch Break

1:30pm - 3:00pm -

Safety Measures

3:00pm — 4:00pm

Valedictory Function

Jiad
i
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CMR COLLEGE OF ENGINEERING & TECHNOLOGY

’o‘ (AUTONOMOUS)
CMR NAAC Accredited Institution with ‘A’ Grade
CALARE TP IRRENY Kandlakoya (V), Medchal Road, Hyderabad -501401.

Date: 09-07-2017

From,

Principal

CMR College of Engineering & Technology
Kandlakoya (V), Medchal Road,

Hyderabad — 501401

To
The Sarpanch
(K& 21¥) v)

Subject: “Request for Heraldic in your village for 3-day Training Session™- Reg.

For the benefit of unemployed youth and for attaining the skill on CNC Turning Machine, I request
you to heraldic in your village and encourage the unemployed youth to participate in the skill development
program for free of cost.

Thanking You,

s

Major Dr. V. A. Narayana

Principal
PRINCIPAL
CM2 COLLEGE OFENG . & T
Kan ixva (V), Med=n + Road,

\r////'//.,.. Hyderabad-501

-



CMR COLLEGE OF ENGINEERING & TECHNOLOGY

(AUTONOMOUS)
VLR NAAC Accredited Institution with ‘A’ Grade
EXPLORE TO INVENT Kaﬂdlakoya (V)‘ Medchalﬁoad, Hyderabad -501401.

Date: 09-07-2017
From,
Principal
CMR College of Engineering & Technology
Kandlakoya (V), Medchal Road,
Hyderabad — 501401

To
The Sarpanch

 Puduv )

Subject: “Request for Heraldic in your village for 3-day Training Session™- Reg.

For the benefit of unemployed youth and for attaining the skill on CNC Turning Machine, I request
you to heraldic in your village and encourage the unemployed youth to participate in the skill development
program for free of cost. '

Thanking You,

\/R.i 2 /_-—
Major Dy MicypNirayana
CMR COL! PrinciprENGT £ TEC!

Kandiakeya (V) Medc’ '; Road
Hyo‘afabad-501-1u :




with ‘A’ Grade
Hyderabad -501401.

Kandlakoya (V), M

ety - AR
EXPLORE TO INVENT

Date: 09-07-2017
From,
Principal
CMR College of Engineering & Technology
Kandlakoya (V), Medchal Roac
Hyderabad — 501401

T -

%ﬁ Sarpanch

Subject: “Request for Heraldic in your village for 3-day Training Session™- Reg.

For the benefit of unemployed youth and for attaining the skill on CNC Turning Machine, I request
you to heraldic in your village and encourage the unemployed youth to participate in the skill development
program for free of cost.

Thanking You,



VIR NAAC Accreditetf gt with ‘A Grade
EXPLORE TO INVENT Kandlakoya m' Medchal m Hyderabad 501401

Date: 09-07-2017
From,
Principal
CMR College of Engineering & Technology
Kandlakoya (V), Medchal Road,
Hyderabad — 501401

To
The Sarpanch

ot

Subject: “Request for Heraldic in your village for 3-day Training Session™- Reg.

: the skill on CNC Turning Machine, I request
youtohﬁmldicmmvﬂlww youth to participate in the skill development

Thanking You,




:RING & TECHNOLOGY
e

S VN NAAC Accredited Institution with ‘A’ Grade
e Kandlakoya (V), Medchal Road, Hyderabad -501401.

Date: 09-07-2017
From,
Principal
CMR College of Engineering & Technology
Kandlakoya (V), Medchal Road,
Hyderabad — 501401

To
The Sarpanch
e

(] Rolorvonn)

Subject: “Request for Heraldic in your village for 3-day Training Session™- Reg.

For the benefit of unemployed youth and for attaining the skill on CNC Turning Machine, I request
you to heraldic in your village and encourage the unemployed youth to participate in the skill development
program for free of cost.

Thanking You,

CIPAL

NG . TECH\

' ) [\ co 2! Road
’;"‘. ol \ ' KantééV) Medc.k.:,- —0dQ,

Vafs(Narayana
Principal
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CMR College of Engmeermg & Technology
Kandlakoya, Medchal Road, Hyderabad -501401
3-Day

HANDS ON EXPOSURE ON

CNC € 6 pYele 30 5
3890 585500 &

For Unemployed Youth

i 15/07/2017 to 17/07/2(
Organized by *‘/:/’

NAIPUNYA CLUB

CMR College of Engineering & Technology

Kandlakoya, Medchal Road, Hyderabad -501401
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Hands on Exposure on CNC Turning Machine - 3 days Course
CONTENT

Overview of Numerical Control

A new technique for controlling the machine / production tools, the Numerical Control (NC) was developed in mid 50's.
Prior to this, all the machine / production tools were manually operated and controlled. Quality of the products produced
by manually operated machines is totally dependent on the skills and mind status of the human operator. Numerical control
machines are more accurate than manually operated machines, can produce components more uniformly, faster and in the
long-run tooling costs are smaller but the initial investment is higher.

Numerical Control (NC) has been defined by the Electronic industries Association (EIA) as 'a system in which actions
are controlled by direct insertion of numerical data at some point'. This s -stern automatically interprets symbolic
instructions (numerical dai3) to control machine tools and other manufacturing systems. Symbolic instructions or the
numerical data required to produce a part is called a 'part program’.

Traditionally, in "the NC machining, part drawing of the component to be machined is studied by the NC
programmer who translates the information on the drawing to the necessary programme which issues operational
instructions to the machine tools. The programme represents the path or action at every momment that the machine tool
must take to properly machine the part as described by the engineering drawing.

In the initial stages of NC development the programmed instructions stored on punched tapes where interpreted by
electromechanical tape readers connected to the machine tool. The main problem with tapes was that it was very difficult
to change the instructions on the tape. Even to make very minor instructions in the programme, new tape had to be made in
addition to interrupting machining. Operations. Another draw-back of using the tapes was that they had to be run as many
times as the number of components required, which decreased the life of tape.

With rapid developments in computer technology and its capabilities, the problems associated with punched
paper/plastic tape were solved. Rapid development in computer technology extended numerical control (NC) to direct
numerical control (dNC), computer numerical control (CN C) and distributed numerical control (DNC).

Host Computer

Host Computer

Nerwork Linkage (LAN)

e g

jmmmmeesd, N Machine
A5 B SR e EReies I i
Tools 7 Rl !
e - kil b= =1 NC Machine | =
=} 5—"=1 Tools B

T AR I & . -1
15,13 bhrect auinerical control 3 7 ;
. ; Fig. 15.14 Distributed numerical ¢ontrol

The problems faced by NC lead to the development of a concept known as direct numerical control (ANC) which eliminates the
use of tape as a medium of carrying the programmed instructions. In dNC many machine tools are connected to a host computer
through a data transmission link as shown in Fig. 15.13. Here, the NC programmes requirred to operate the machines are stored in
the host computer and are fed to the machine tool connected through the data transmission lines. Even though dNC eliminates the
use of tape, it will suffer whenever the host computer goes down. This shortfall of dNC led to the development of computer
numerical control (CNC) which allowed NC machines at remote locations to be connected to the host computer.

Distributed numerical control (Fig. 15.14) \Was developed by combining the positive point of both direct numerical control (ANC)
and computer numerical control (CNC). Hence, in distributed numerical control (DNC) both host and local computers are present
at individual machine tool. Here host computers are used as main storage devices and programmes are down- loaded to the mini-
computers present at various machines where they are stored or transmitted to the NC machines. Mini- computer controllers also
serve as back-up memory whenever the host computer is down. Therefore, the NC machines do not have to be down when the
host computer is down. An effective data transmission network from the host computer to the micro-computer controls the NC
machines and is key to the success of distributed numerical control systems. In rest of this book, NC is used as synonym for CNC
Various components present in NC machine tool are:

. Machine tool

., Machine Control Unit (MCL)

. Communication interface and accessories
“The machine tool may be any type of machine tool used in the manufacturing industry. Machine control unit (MCV) is the control
unit that reads and interprets the numerical data/part programmed from the tap or any other media and passes on this information
in the form ol clectrical signals to various activators / drive mechanisms of the machine to operate the machine tool in the desired
way. =




Numerical-Control Programming

NC PART PROGRAMMING

Coordinate Systems

In an NC system, each axis of motion is equipped with a separate driving source that replaces the hand wheel of the
conventional machine. The driving source can be a DC motor, a stepping motor, or a hydraulic actuator. The source
selected is determined mainly based on the precision requirements of the machine, as described in Chapter 9.

The relative movement between tools and workpieces is achieved by the motion of the machine tool slides. The three
main axes of motion are referred to as the X, Y. and Z axes. The Z axis is perpendicular to both the X and Y axes in order to
create a right-hand coordinate system, as shown in Figure 10.1.A positive Motion in the Z direction moves the cutting tool
away from the workpiece. This is detailed as follows:

Z AXIS
1. On a workpiece -rotating machine, such as a lathe, the Z axis is parallel In the spindle, and the positive Motion moves

the tool away from the workpiece (figure 10.2).

2. On a tool-rotating machine, such as a milling or boring machine, the Z axis is paraliel to the tool axis, and the
positive motion moves the tool away from the workpiece (Figures 10.3 and 10.4). :

3. On other machines, such as a press, a planing machine, or shearing machine, the Z axis is perpendicular to the tool
set, and the positive motion increases the distance between the tool and the workpiece.

X AXIS
1.0n a lathe, the X axis is the direction of tool movement, and the positive motionmoves the tool away from the
workpiece :
2. On a horizontal milling machine, the X axis is parallel to the table.
3. On a vertical milling machine, the positive X axis points to the right when the prorammer is facing the
machine.

The ¥ axis is the axis left in a standard Cartesian coordinate system.

e &
e

NC Program Storage Media

Modern CNC controllers provide several ways ol transferring data. Perhaps the most typical data-communication methods
used to transfer part program files is an RS-232C interface (see Chapter 8). An NC part program is stored in a file on a
computer or a CNC controller. The file download (or upload) can be initiated by setting up a transfer mode on the CNC
controller. On the other side of the communication cable is a computer that sends or receives data byte by byte. The
operator must start and end the data-transfer process on both the CNC controller and the computer. Some machines use
higher-level protocols to ensure an error-free data transfer. Two of the higher-level protocols used are Kermit and
Xmodem. Kermit and Xmodem are widely accepted in the computer- to-computer telecommunication file-transfer process.
These protocols allow the lile transter to be controlled by either the computer or the controller. The computer can send and
retricve data directly.

Some machines also provide local-area network (LAN) instead of serial communication. Ethernet and MAP are two
technologies used. Some CNC controllers allow the entire controller function to_be initigted from a remole computer
through the data-commumcation network. - EFS g 8 P




G CODES
Goo Rapid traverse G40  Cutter compensation cancel
Go1 Linear interpolation G41 Cutter compensation left
Go2 Circular interpolation CW G42 Cutter compensation right
G03 Circular interpolation CCW G70 Inch format
Go4 Dwell G71 Metric format
GO08 Acceleration G74 Full-circle programming off
Go09 Deceleration G75 Full-circle programming on
G17 X-Y plane G80 Fixed-cycle cancel
G18 Z-X Plane (81-89 Fixed cycles
G19 Y-Z Plane G900  Absolute dimension program
G91 Incremental dimension
M-CODES
MO0  Program stop MO06 Tool change
MO1  Optional stop Mo07 Flood coolant on
M02  End of program MO8 Mist coolant on
M03  Spindle CW M09 Coolant off
M04  Spindle CCW M30 End of tape
LATHE
Description of G Commands
g ‘GO0 Positioning (Rapid Traverse)
o : Format
paree® N.... GO0 X(U)....Z(W)....

ABSOY ind ST OUATIEN P aLUES for GOT

B bt S

COURSE OUTCOME

1. able to Estimate machining time

The slides are traversed at maximum speed to
the Programmed target point

Incremental and absolute commands can be
used at the same time.

Note

+ A programmed feed F will be suppressed
while G0O

* The maximum feed is defined by the producer
of the machine.

» The feed override switch is limited to 100%

GO1 Linear Interpolation (Feed)

Format
N.... GO X(U).. . Z0W) - E.

Linear slide movements (face,
turning) at the programmed federate.

longitudinal,

2. able to calculate torces during orthogonal metal cutting.

3. able to implement the knowledge of machining processes in Manufacturing Industries.

4. able to Difterentiate chip torming processes

1
.

taper



Réport on

Hands on Exposure on CNC Turning Machine
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 15-07-2017 to 17-07-2017,
Time: 9 am to 4.00 pm
Venue: CMR Collége of Engineering & Technology
Event report:

IQAC have organized a unemployed youth skill development program on Lathe Machine to the unemployed
youth of nearby five villages. The main objective of this training is to focus on training the unemployed
people towards increase in their chance of employment.

In these three days the trainees are explained by Lathe machine introduction, Types of Lathe machines,
Mechanisms of Lathe machines, Applications of lathe machines.

We explained about Computer Numerical Control, Absolute coordinate system, Incremental coordinate
system, G-Codes, M-Codes.

At the time of visit to the lab we explained the practical parts of lathe machines and the mechanisms were
shown to them.

Then we showed how to work on lathe machines with safety precautions. They were given by designs of
work to be turned and under the guidance of lab assistants the operations were conducted.

No. of Participants attended the session: 10

Venue: CAPD/CAD/CAM Lab, CMRCET

Overall Feedback: As per discussion with the people involved in the session, the topic covered was
appreciated by most of the participants and requested to arrange such hands on with advancements in the
future also.

Outcome: Participants are in a situation to estimate the working methods on lathe and appropriate
techniques for better utilization of Machine.
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Attendance sheet:

S.No

Name

Signature
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FEEDBACK FORM
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&é% CMR COLLEGE OF ENGINEERING & TECHNOLOGY
d (AUTONOMOUS)
CMR NAAC Accredited Institution with ‘A’ Grade
AHRIRTO Kandlakoya (V), Medchal Road, Hyderabad -501401.
Date: 10-07-2017

To
The Principal,
CMR College of Engineering & Technology,
Hyderabad.

Through: Coordinator, IQAC, CMR College of Engineering & Technology.
Respected sir,

Subject: Approval for organizing a “BRIEFING SESSION ON INTRODUCTION TOMS — WORD”
for IX class students, ZPHS Muneerabad — Reg.

As per the request received from Head Master, ZPHS Muneerabad, We are willing to organize a
1-day guest lecture through NAIPUNYA Club. The topic of the guest lecture is “BRIEFING SESSION _
ON INTRODUCTION TO MS — WORD?” for IX class students, on 22-07-2017 at ZPHS Muneerabad.

The main objective of this lecture is to enhance the skill set of the school students.

Resource persons for this training were:

CHITLA SIDDARTHA, 15H51A0411, B.TECH, ECE Ill Year, CMRCET.

SAHITHI BONDUGULA, 15H51A04P2, B.TECH, ECE III Year, CMRCET.

J VIJAYA KRISHNA SAMEERAJ, 15H51A0585, B.TECH, CSE III Year, CMRCET.
EARVA KIRANMALI, 16H55A0506, B.TECH, CSE IIl Year, CMRCET.

G S AKHIL, 15H51A04D4, B.TECH, ECE III Year, CMRCET.

B TR, e

The objectives of the guest lecture are, to make students to:
e Examine the basic features of MS — Word, Illustrate the format text and styles.

o Outline the features such as create, edit, save, and print documents to include documents with

lists and tables. «/ ST

o Classify header, footer, adding footnote to a document. it
¢ Add a graphic to a document. P!
o Compare the use of Spelling and Grammar Checker as well as Microsoft Help.

o Create the documents using functions such as find and replace; cut, copy, r_gblacc.

[ b

A Dr%a Rao
. W ¢£) Convener - Naipunya Club
oYY~ — A CMRCET.

1%
MaA, N 5
Head of the Department 0
Dept. of Master of Business Administraon n \(‘//—’
~MR Coflege of Engineering & Technolor \




CMR COLLEGE OF ENGINEERING & TECHNOLOGY

@ (AUTONOMOUS)
CMR NAAC Accredited Institution with ‘A’ Grade
s Kandlakoya (V), Medchal Road, Hyderabad -501401.
15-07-2017
Hyderabad
To

Head Master,
ZPHS Muneerabad,
MEDCHAL.

Sir,

Sub: Willingness to conduct a Guest Lecture on “BRIEFING SESSION ON INTRODUCTION TO
MS — WORD” by CMRCET B. Tech students -Regarding

As per the earlier discussion over telephonic call, I bring to your kind notice that students of CMRCET
are interested in conducting a guest lecture session to the students of ZPHS Muneerabad. Our students
are well versed with the MS-WORD and are willing to take a session on the same to your students which

will be good takeaway for the school students.

In this regard, | request you to provide an opportunity for our students. I also request you to provide the
following particulars.

1. Computer System

2. LCD Projector

3. Digital Classroom

B

Major. Dr. V. A. Narayana

Principal
CMRCET
PRINCIPAL
e CMR COLLEGE OF ENGG. & TECH.
_KC/, Kandlakoya (\'), Medchal Road,

L Hyderabad-501401.

il



A REPORT
Of

BRIEFING SESSION ON INTRODUCTION TO MS — WORD

(Conducted by Naipunya Club)

Naipunya Club of CMR College of Engineering & Technology has conducted a Guest
Lecture on INTRODUCTION OF MS- Word for IX class students at ZPHS Muneerabad on
22-07-2017. The speakers of the lecture were given below.

CHITLA SIDDARTHA, 15H51A0411, B.TECH, ECE Ill Year, CMRCET.

SAHITHI BONDUGULA, 15H51A04P2, B.TECH, ECE Il Year, CMRCET.

J VIJAYA KRISHNA SAMEERAJ, 15H51A0585, B.TECH, CSE Il Year, CMRCET.
EARVA KIRANMAI, 16H55A0506, B.TECH, CSE Ill Year, CMRCET.

G S AKHIL, 15H51A04D4, B.TECH, ECE Ill Year, CMRCET.

v B W N =

In this lecture, the speakers discussed how to use, create, format and advance options in
MS- Word. 30 students participated in the session. All the participants actively involved in the

session. They were given exposure to the basics of computers in detailed.

Key points discussed in the session are:

Creation of document.

Edit, save the document.

Print the document.

Inserting the picture, clip art, shapes, charts in the document
Header, Footer, Page number

Break, watermark, page border

WOl L

Cut, copy, paste, replace.

Outcome: Students are able to create the MS-Word document and able to use the options of

MS-WORD which is useful for the development of project documentation skills.




BRIEFING SESSION ON INTRODUCTION TO MS - WORD

Date: 22-07-2017

S.No Name ~ Signature
[ Kasuna %r{ﬁ
=1 Rpuit -
3, a5ot &8
Y., Santeshi Savithoth
5. < abasi L ibasi
G- Sody -
3. f{ nlmo %&
% Anid Y
9. Provan (o0
[oF Toacara. tra cama
A3 €€ enthT £
L 00 (T @,
(3-S50 Sk
4 | Spordom Spaudnisasn
% deoisan :fé.,vmg—
16- | Rokial Kot
= e ot o g
2OEO0 ON oo




BRIEFING SESSION ON INTRODUCTION TO MS - WORD

Date: 22-07-2017
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Picl: After Arriving to the village

Pic3: Students explaining about the
Session

Pic2: Students explaining about the
Session

Pic4: Interaction with students




FEEDBACK FORM

Title: MS - Word

I

>

Is the content easy to understand the concept?

/ﬁYes [] No

How would you rate Presenters” knowledge in the subject?
& Exce]lcn@est [] Average [] Poor

How would you rate the presenters’ style of teaching?
¥ 3w s e SLew
How would you rate the pace of the presentation?

“(,I’o/o. fast Too slow Just right)

What did you like most in the session?

Q | e “'A\—K\JS

Any suggestions:

O

Date: 22-07-2017
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FEEDBACK FORM

MS - Word

Is the content easy to understand the concept?
[] Yes Eﬁ\lo
How would you rate Presenters’ knowledge in the subject?
[] Excellent P Best [ ] Average [] Poor
How would you rate the presenters’ style of teaching?
1° 2 R Y Do
How would you rate the pace of the presentation?
(Too fast «’[" go slow Just right)
What did you like most in the session;?

kg A
Any suggestions:

it

Date: 22-07-2017
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: MS - Word

Is the content easy (o understand the concept?

u{‘;es [] No

. How would you rate Presenters’ knowledge in the subject?
0] Excellent«[ﬁest [] Average [] Poor

How would you rate the presenters’ style of teaching?

1 4 3 ‘4 5 (1 High, 5 Low)

How would you rate the pace of the presentation?

(Too fast ﬂ‘&) slow Just right)

. What did you like most in the session?

—
S Ry )

Any suggestions:

=

Date: 22-07-2017




FEEDBACK FORM

Date: 22-07-2017

Title: MS - Word

[

. Is the content easy to understand the concept?

D/Yes [] No -

2. How would you rate Presenters’ knowledge in the subject?
mxcelient []Best [ ]Average [] Poor
3. How would you rate the presenters’ style of teaching?
1 2 “3/ 4 5 (1 High,5 Low)
4. How would you rate the pace of the presentation?
(Too fast Tooslow  Justright)

5. What did you like most in the session?

6. Any suggestions:
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CMR €O & TECH.
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Date: 22-07-2017
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FEEDBACK FORM

Date: 22-07-2017

Title: MS - Word

1. Is the content easy to understand the concept?

[] Yes E]/No

2. How would you rate Presenters’ knowledge in the subject?

[] Excellent []Best []Average [} Poor

3. How would you rate the presenters’ style of teaching?

1 2 3 4 @ (1 High , 5 Low)

4.. How would you rate the pace of the presentation?

Too slow Just right)

5. What did you like most in the session?
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Date: 22-07-2017
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Title: MS - Word
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0. Any suggestions:
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g L1 EGE OF ENGG. & TECH.
Kandlakoya (V), M’ecf:i“a.: Road,
Hyderabad-501401.
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PRINCIPAL
"MR COLLEGE OF ENGG. & TECH.
Kandlakcva (V), Medchal Road,
H yat rabad-501401.
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2. How would you rate Presenters’ knowledge in the subject?

(] Excelltm‘{-‘ Best [ ] Average [] Poor

How would you rate the presenters’ style of teaching?
} 3 Cs\ 4 5 (1High,5 Low)
How would you rate the pace of the presentation?
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What did vou like most in the session?

s i

Any suggestions:

Ve

PRINCIPAL

CMR COLLEGE OF ENGG. & TECH.
Kandlakoya (V), Medchal Road,
Hyderabad-501401.
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° .\!‘ CMR COLLEGE OF ENGINEERING & TECHNOLOGY [

(AUTONOMOUS) e
'NAAC Accredited Institution with ‘A’ Grade )
il Kandlakoya (V), Medchal Road, Hyderabad -501401.
Date: 16-08-2017

To
The Principal,
CMR College of Engineering & Technology,
Hyderabad.

Through: Coordinator, IQAC, CMRCET.
Respected sir,

Subject: Request for organizing a “Guest lecture on Introduction to PowerPoint” for IX class students,
ZPHS, Ravalkole — Reg.

This is to bring to your notice that NAIPUNYA Club is planning to organize a “Guest lecture on

~ Introduction to PowerPoint” for IX class students, on 26-08-2017 at ZPHS, Ravalkole.
Resource persons for this training are
1. Battu Shruthika 16H51A05)7
2. Gandesiri Pravalika 16H51A05K7
3. Yengannagari Nishitha 16H55A0446
4. Pippoji Rushikeshchandra 15H51A0442
5. K Shahbaaz 15H51A0488
The objectives of the guest lecture are, to make school students )2
e Work with the basic features of PowerPoint QA H’d?"éﬁ___,_,
e Create a new presentation W ’CCS
e Work with the various slide layouts \-’4’ D
e Create and work with Smart Art graphics =
e
e Draw and format shapes , . A (, pwJ
e Navigate a slideshow in PowerPoint O QMW)S " :
e Use a range of printing techniques MM [{ (},,..J
e Follow the procedures for using various forms of Help F 0 } v bC
e Create brilliant presentations. 9 C (\va ror—t
In this regard, I request you to accept the proposal. L"" ) we N
Thanking You. A I
A~
: O
ccs®
3 c 3 : .
ROy \ b )b Naipunya Club,

F O W CMRCET.

o S



: \\.‘ CMR COLLEGE OF ENGINEERING & TECHNOLOGY
CMR

(AUTONOMOUS)
LY LIN NAAC Accredited Institution with ‘A’ Grade
s Kandlakoya (V), Medchal Road, Hyderabad -501401.
Date: 18-08-2017,
Hyderabad.
To
The Headmaster,
UPS Kistapur,
Medchal.
Respected Sir/Madam,

Sub: Permission to conduct a “Guest lecture on Introduction to PowerPoint” for IX class students,
ZPHS, Ravalkole on 26-08-2017, by CMRCET students, B.Tech Students - Reg.

With reference to the above-cited subject, I bring to your kind notice that students of CMRCET
are interested to conduct a “Guest lecture on Introduction to PowerPoint” for IX class students, ZPHS, )
Ravalkole on 26-08-2017. With the help of this lecture, students will be able to make powerpoint

presentations.

I request you to consider our request.

’ OF £y :
;:;v’ /A\:q:‘?}-"‘ /

CMR
7”'?\,?// Major.Dr V A Narayana,
R Principal,
CMRCET

PRINCIPAL
CMR COLLZCE OF £NGG. & TECH.
Kandiake . v ) w1adcnal Road,
H u‘\.}iqui.

o iy | L Al



REPORT
OF
GUEST LECTURE ON
INTRODUCTION TO POWERPOINT

CMR College of Engineering & Technology has organized a Guest Lecture
INTRODUCTION OF POWERPOINT for IX class students at ZPHS, Ravalkole on 26-08-2017.
The speakers of the lecture are

|. BATTU SHRUTHIKA- 16H51A05J7

2. GANDESIRI PRAVALIKA - 16H51A05K7

3. YENGANNAGARI NISHITHA - 16H55A0446

4 PIPPOJI RUSHIKESHCHANDRA - 15H51A0442
5. K SHAHBAAZ - 15H51A0488

In this lecture, the speakers discussed how to use, create, format and advance options in
PowerPoint. About 27 students of ZPHS, Ravalkole participated in the session.

This lecture was aimed to provide new PowerPoint users with the essential skills needed
to create, edit and present professional-looking presentations using text, tables, diagrams, charts,
and pictures as well as providing presentations tips.

\
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OUTCOMES:

At the end of this Guest lecture, students will be able to

Work with the basic features of PowerPoint
Create a new presentation

Work with the various slide layouts

Create and work with Smart Art graphics

Draw and format shapes

Navigate a slideshow in PowerPoint

Use a range of printing techniques

Follow the procedures for using various forms of Help
Create brilliant presentations.

Date: o8 - 22! 7

Place: o7 H‘(i‘“"‘\""’q
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o CMR COLLEGE OF ENGINEERING & TECHNOLOGY
(UGC Autonomous)

o NAAC Accreditation with A — Grade
Kandlakoya, Hyderabad— 501 401
GUEST LECTURE ON
INTRODUCTION TO POWERPOINT
Date: 26-08-2017
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.2 CMR COLLEGE OF ENGINEERING & TECHNOLOGY

(UGC Autonomous)
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GUEST LECTURE ON
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Introduction to PowerPoint

CPAP
Kog University

iOutline i@

» Creating and Formatting
o From scratch
a Templates
o Adding and formatting graphics
a Footers
= Advanced
a Slide Master
a Creating and setting up a custom show
o Adding slide transitions & animations
o Using more than one theme.
o Handout, Notes and Printing

| What Can You Create?

s On screen presentations

= Web pages for web use

= Color and B&W overheads
= 35 mm slides

» Audience handouts

= Speaker notes
s etc..

| When You Open Power Point

Power Point menu and toolbars are just like the other Office applications

Home Toolbar
By, Bl

Insen Toolbar
“

o8 udl

Design Toolbar
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| Installed Templates & Themes

You can choose the installed tempiates and themes of Office for the new presentation

Instalied Tempiates

%E  installed Themes

| Slide Master

= A master is a slide that contains the text and other
objects that appear on all slides of the same type.

= PowerPoint presentations have two types of
masters:

a Tll_:grille Master contains objects that appear on the title
sli

a The Slide Master contains objects that appear on all slides

except the title slide
= You will use the masters to make design changes

that you want to appear on every slide:

a If you want your company logo to appear on the bottom
right of every page, you will add it to the Slide Master

o If <;ou wanl! a picture of your office on a single slide, you
add the picture to only that slide

| Slide Master

You can change the design and layoul of the masler shde
To open the masier shde window chick on the “Shde Master icon on the view toolbar

Click to edit Master utle style

I Slide Master

You can chooso
the desired
shde master
from pane
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| When You Open Power Point | When You Open Power Point

Animations Toolbar :

ﬂzé S i A S Lo
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b Rt = ﬂh, B R e 4 b i
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| When You Open Power Point

BwaMMmaMm.MmmmMaum
templates by clicking “New" from the menu pops from the Office Button

Click to add title

‘You can change the template
_, and theme of the presentation

—
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1 Start From Scratch

‘gxﬁ‘.;\u‘m S
S ik ve e Miaates S st

Slide Master
choices

= Pick a layout from
Slide Master Pane
in the Slide Master
window.

= Choose a Layout
that best matches -
the information you
want to put on the
presentation.

Scroll to see
more Layouts

| Placeholder in Layout

Title Placeholder
» Follow the on-screen

. = " LA e
instructions to click e
and type your text

into the placeholders

* Click 1o add text

on the slides -
= Click on “New Slide”" .
from the Home A
toolbar.
Bulleted Text
Placeholder

Content in Placeholders become Lists
Slide layouts that include

a content placeholder where

you can add text, or use Bk ooyt
graphical commands 1o insert TeamExercise #oP*  Pasosn
tables, charts, SmartArnt aldint

graphics, pictures, clip ar,
and media clips. On these
slides, a bullet appears to the

| Creating a new presentation from
an existing design template

« Click Office Button and " =,
then click New o

= Click the Installed L
Templates link in the New [-—
Presentation window

= Click the design template

left of the placeholder text. If o you want to use '
you choose to add text, rather « You can save the existing
than using one of the template from New From
graphical commands o insert e Existing link
an item, the text is formatted y
into a list by default +
PRINCIPA
- PAL
. G. & TECH.
‘ Road,

{ \ 4
s i 5 f B
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Ereating a new presentation from
an existing design template

= Templates give you a starting point and make
it easier to complete your presentation
quickly. You can modify a template's text and
design, add a company logo, add your own
images, or delete text or other content from
the template.

| Changing the Slide Layout

You can change the layout of a slide by selecting a design
from the drop down menu of Layout icon in Home toolbar.

llick to add title

el ext

fWorking with Di‘fferent Views

= Normal view
a Qutline view
o Slide view

= Slide sorter view
= Notes Page
= Slide show

You can acces the presentation view options
from “View" toolbar.

s wad

R/'iews: Normal View...3 Views in 1

The text outline of your Slide Pane
presentation is in the e -
left pane. \
The current slide with |
all your graphics and
objects is in the right
pane.

Notes appear in the

small pane below the
Slide Pane.
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I Inserting footers and slide numbers

You can insert Header&Footer and Slide Numbers from Insert toolbar

By vl ¢ o
TR N e Dy et et Wl v emsed | et

| Inserting footers and slide numbers

When you click on “Header & Footer” or “Slide Number” buttons, Header
and Footer dialog box will be opened.

Select to show e R

Ll S [ 2L B e B "
W b g.-.r..:... . W i :i... e e e -%’ e Dale and Time on | % istmesesint A
i -l - the siide "&1:‘-‘::- @ i
! S
Select to show E .
slide number on | Gikin i
All open the Header & Footer dialog box each slide P i indicates position
which allows you to insert fooler, date. \rr ~+ of the slide number
and shde number 3 i text box
Footer text //%---”
A
5 Select to hide footer text =
) boxes on title slide =
| Inserting Graphics |Insertmg Graphics (clipart)

» On the slide you wish to insert the graphics,
from Home toolbar click on the little arrow
next to “Layout”

= Choose a slide layout containing a content
placeholder

» Click the content button of your choice in the
content placeholder (clipart, file, etc.)

= Locate the graphic you wish to insert, and
click the OK button

- S R »
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| Insert and resize pictures

and clip-art images

= PowerPoint comes with a gallery of clip art that you
can insert into your presentations.

= You can modify clip art by changing its size,
grouping or ungrouping its components, changing
some of its colors, or applying animation effects.

= You can also insert and modify pictures from other
file sources, such as a CD, into your presentations.

= When you insert a picture or clip art, you might need
to adjust the size of the object to fit your layout.

a Todo so, click on the resize handles that appear when the
object is selected and drag in or out

| Inserting Chart

+You can embed and insert a chart in your presentation (embedded
object: Information (object) contained in a source file and inserted into a
destination file. Once embedded, the object becomes part of the
destination file. Changes you make to the embedded object are reflected
in the destination file.) When you embed data from a chart in
PowerPoint, you edit that data in Office Excel 2007, and the worksheet is
saved with lhe PowerPoint file.

*You can paste an Excel chart into your presentation and link to data
in Office Excel 2007 When you copy a charl from Office Excel 2007 and
paste it into your presentation, the data in the chart is linked to the Excel
worksheet, If you want to change the data in the chart, you must make
your changes to the linked worksheet in Office Excel 2007. The Excel
worksheet is a separate file and is not saved with the PowerPoint file.

I Embed and insert a chart in your
presentation

- i

= In PowerPoint, click the Insert - S
Chart icon in the placeholder that ::”

you want to contain the chart or o
on the Insert toolbar click Chart b ]

= In the Insert Chart dialog box,
click a chart, and then click OK gl

| Embed and insert a chart in your
presentation

- Office Excel 2007 opens in a split window and displays sample data on a
worksheet.

+In Excel, to replace the sample data, click a cell on the worksheet, and then
lype the data that you want. You can change the chan lype and axes ophons
as seen in Excel lectures. e

= Note After you update
the worksheet, the chart in
PowerPoint will be
updated automatically with
the new data.
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| Paste an Excel chart into your
presentation and link to data in Excel

= You can create and copy the chart in Office Excel 2007
and then paste it into your PowerPoint presentation.
When you update the data in Office Excel 2007, the
chart in PowerPoint is updated as well.

= In Excel, select the chart by clicking its border, and then
on the Home toolbar click Cut.

= In PowerPoint, click the placeholder on the slide that you
want to insert the chart on.

« On the Home toolbar click Paste.

I Create a table

= PowerPoint enables you to insert tables into slides
in much the same way that you would insert tables
into a Word document.

= Tables are useful on slides when you want to
arrange information horizontally in rows and
vertically in columns.

= Toinsert a table: :
o Change the layout to Title and Content and click on

Table icon from the content part.

o Define the number of columns and rows
o Add information to the table

[ A slide with a table

ri Inserting a Table
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l Insert a movie

1-To Insert a Movie from a File on Your Computer:
Selecl the slide where you wish to nsert the movie
Seiect the Insert tab

Click the drop-down arrow on the Movie command in
the Media Clips group

Select Insert a Movie from File from the menu The eSS
Insert Movie dialog box will appear B s i b
Locale the file you want 1g insert from your computer Lo

Click the file name.

Click OK. The movie will appear on the slide The Movie
Tools Options tab and Picture Tools Formal lab appears
on the Ribbon when the movie is inserted

A dialog box will appear Click Automatically or When
Clicked Automatically will start the movie automatically
as soon as the slide appears in side show view and When
Clicked will start the movie when you chick

Who We Are
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I Wortking with Mo

vies
1-To Preview the Movie: @
Select the movie on the slide.
Select the Options tab.
Click the Preview command in
the Play group.
Press the Preview command again to stop
the movie before it finishes playing.

2- To Change the Movie Volume:

Select the movie on the shide.

Select the Options tab.

Click the Slide Show Volume command in
the Movie Options group.

Select Low, Medium, High, or Mute to change
the movie volume.

I Working

(3l g ot [ty BT Loty ) gt

) paute b Show ] g siovic: e Mgty |
e o

et -2 Py Pt s

with Movies

1.To Change When the Movie Starts:
Select the movie on the slide.

Select the Options tab.

Select the drop-down menu next to Play Movie: in the Movie Options group
to change whether the movie playsAutomatically or When Clicked.
2-Other Options

Click a box to select and deselect movie options on the Movie Tools Options
tab. These options are: NOTE: Picture Tools Format Tab

Hide During Show ommands on the Forn !
Play Full Screen i
Loop Until Stopped style can be applied to ;
Rewind Movie After Playing

I Working with Sounds

To Insert a Sound File from Your Computer:
Select the slide where you want to add sound
Select the Insert tab

Click the drop-down arrow on

the Sound command in the Media Cips group
Select Sound from File from the menu The
Insert Sound dialog box will appear

Locate the sound file on your computer

Select the file

Click OK. A sound icon and a dialog box will
appear

Select Automatically or When Clicked

Click Automatically or When Clicked
Automatically will start the sound automatically as

| Sound Options

Preview: Listen to the sound that will play] B | S 5 mcoesim. & s soe famiss
Slide Show Volume Change the volume | ™ sk st
to low, medium, high, or mule -
Hide During Show: Hide or dispiay the
sound icon during the slide show.

Loop Until Stopped Sound will play until
you slop it by clicking or advancing (o the
nexl slide.

1-To Play Tracks from a CD:
Select the Insert tab

Click the drop-down arrow on
the Sound command

Select Play CD Audio Track from the meny | Jeesrsmsssssse
The Insert CD Audio diaiog box will appear. |

Enter the Start at track: and End at e il

s00n as the siide appears in shde show view and track: information in the Clip 2 )]
When Clicked will start the sound when you click ” selection seclion
5 "
INCIPAI
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| Add Visual Effects To Create
Animated Slide Shows

= Animation Schemes
a Custom Animation

= Slide transition
= Action Buttons

| Working with Animation Effects

« 1-To Animate Text with a Default am
Animation:

- Select the text box or text you wish
to animate on the slide.
Select the Animations tab.
Click the Animate drop-down menu
in the Animations group to see
the animation effects for the
selected text. The effects vary based
on the selected item.

+  Select an animation effect.

+ B EXIO VI A 2. By 1st Level Paragraphs The text will
appears all at once. The entire text bullet by o . appear
; s bullet, or p
ls.labele_d with one number on ths paragraph. Each ..m s labeled with
slide. Click the drop-down arrow in a different number on the siide. Click the
the task pane to expand the drop-down arrow in the task pane to expand

k the contents and see that the text i

contents and see that the text is e s e
labeled with one number

| Working with Animation Effects

= 1-To Modify a Default or Custom Animation Effect: Bt o
« After you apply an animation effect, drop-down menus will P
appear ai the top of the Custom Animation lask pane. The S X

menus vary based on the animation effecl nin 2:;:' ;
Selecl an option from a drop-down menu Somact % peissors 1] =

o change the default setting

: ! o I -
Repeat until all menu optiens are the desired setling - -

» 1- To Remove an Animation Effect
Select the text or object on the shide you wish to modify
Select the Animations lab
Chck Custom Amsimation i the Ammations group The
Customn Amimation task pane will appear on the nght .
Select the ammation i the Cusiom Amimabion lask pane kst d .. o s

itis not aiready selected
Click Ry The Tabel will disa from the

slide and from the Custom Ammation lask pane st

| Working with Animation Effects =

1-More Ways to Modify an Animation Effect

Select an animation effect in the Custom Animation
task pane list.

Click the arrow to display a drop-down menu

Select Effects Options or Timing A dialog box will
appear

In the dialog box, add enhancements such as
sounds and define whal happens after the
animation effect is applied to the selected item

The dialog box name is based on the animation
effect name. In the example above, the aruimation
effect is Fade. The tabs and the oplions on the labs

will vary based on the animation effect that is being FAE I

modified.

@
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rApplying Animation Effects

1-To Apply a Default
Animation Effect:

Select the text or object on
the slide you wish to animate.
Select the Animations tab
Click the Animate drop-down
imenu in the Animations group
to see the animation
options for the selection. The
options change based on the
selected item.

Move your cursor over each
option to see a live preview of
the animation on the slide.
Click an option to select it.

| Custom Animation

1-To Apply a Custom
Animation Effect:

Select the text or objecton
the slide you wish to
animate.

Select the Animations tab.
Click Custom Animation in
the Animations group. The
Custom Animation task pane
will appear on the right.
Click Add Effect in the task
pane to add an animation
effect to the selected text or
object.

‘ Custom Animation

. Select Entrance, Emphasis, Exit,

or Motion Path to display a sub menu of

_ animation effects for the category
» Entrance animation effects: Changes
how the selected item appears on the
page
- Emphasis animation effects Draws

attention to the selected item while the

slide is displayed

. Exit animation effects Changes the way

the selected item disappears from the
slide

. Motion Path animation effect Animates

the selected tem so that it movesto a
__specific place on the screen

W W

=
U
#

Lomance L 1

|
“

5 v s +

St o sl 4 20 sk, St
A HAT e 1 k] anate

rCustom Animation

The animation will display on the selected

item on the slide and will appear listed in the},

Custom Animation task pane.

A number label appears on the slide next
to the animated object . Also, a matching
number label appears next to the animation
in the Custom Animation task pane list
Drop-down menus appear at the top of
the Custom Animation task pane You can
define the animation effect in greater detail
here.

The star Play Animations icon appears
beneath the slide on the Slides tab in the
task pane on the left. It indicales that the
slide has an animation effect

D

-
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[ Inserting Tran

sitions

Animations Toolbar

e s e dnk  Wen o Sewme  ssame

A5l Bngedu

ér_

Slide Transitions

To Apply a Transition to
One Slide:

Select the slide you wish to
modify.

Select the Animations tab.
Locate the Transition to
This Slide group. By
default, No Transition is

Slide group By default, No
Transitionis apphbed to each shde
Click the More drop-down arrow to
display all the transition effects,

Click a slide transition effect to apply
it to the selected shde

Click Apply To Al to apply the
transition to all the shdes in the
presentation

that has a transition effect
applied to it, as well as any
slide that uses animation
effects for text or objects. The
icon is visible on the Slides tab
in the lask pane on the left and
in slide sorter view, Click the

star Play Animations icon to
preview the animation or
transition effect

applied to each slide. s J %
Click the More drop-down k
arrow to display all the B e BT
Click Apply fo All Siides to apply WS *—! . ti - “ L
Choose the Click a slide transition o e R ﬂ{
transition type a scheme to all slides. 3
effect to apply it to the Mx W S w.
5 .
| Slide Transitions | Action Buttons
;:: l:::ly a Slide Transition All | = Action Buttons
Select e S Y W 1 o An action button is a ready-made button that you can insert into your
Select the Animations tab A star Play Animations icon PESKOiNan Sl s frypevihy for.
Locate the Transition to This will appear beneath any slide o In PowerPoint, hyperiinks become active when you run your

presentation, not when you are creating it

o Use action buttons when you want to include buttons with commonly
understood symbols for going to the next, previous, first, and last
slides, PowerPoint also has action buttons for playing movies or
sounds. Action buttons are most commonly used for self-running
presentations— for example, at a booth or kiosk

12
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| Action Buttons | Apply multiple themes to a

+First, choose the object that you want to add an action presentauon

+Then, click on the Action button from the Insert toolbar. Do the folllowing to apply a theme 1o a second slide master and a second set of

layouts:

oy _ + NOTE Repeat this step to add more themes to additional slide masters
S and sets of layouts
b + In Slide Master view, in the slide master and layout thumbnail task pane,
Bt scroll down to the last layoul thumbnail in the set.

+ Click just below the last slide layout in the set.
1 Onthe Slide Master tab, in the Edit Theme group, click Themes.

Add an action to the selected object

lo specify what should happen ‘. « Do one of the following:
when you click on it or hover it with ) ; S e o Under Built-In, click the theme that you want.

a Toapply a newly-created theme or an existing theme that you modified

[ Speaker Notes HJRESENTER VIEW

& TR e

Open your PowerPoml presentation E‘ Rt
and go 1o the siide for whech you 4
wanl lo include speaker notes

Go lo the View maenu and select S .3. AT "
" Notes Page » You can read your Use Presenter View
notes on the | Shiow the full-screen siide show
3 Since the notes page will appear % s £ i uziing Presenter View,
very small, go to the View menu, 5 | monitor as you are &
i S This wiew aliows you ta project the
ecmies. i st e « dum Sy giving your ; N sree 1038 A O
" | 3 1 maonitar while viewing a special
L el presentation. The kgl o
4+ Click the text placeholder e audience only sees :';’l::"m“mﬂ and
begin typing your speaser notes { the slide i ‘
q his Teature requires multiple
3 Scrolito the nest shde 1o st wsmﬂkif PFESEHIHHOHV mandars o & aplop with
speaker notes 10 that sivte Notes Section dualisplay capanriities. i

You need 1o have two monitors and use screen resolution
option to enable this feature for the computer and the projector.

" 5
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| Set up a Slide Show :

= To set up a slide show:

a Go to Slide Show toolbar — click on Set Up Show
» Choose “Loop Continuously until ‘Esc” if you want your
slide show to re-run from the beginning until you hit
“Esc” key.
= Choose other options such as whether or not you want
your show to proceed manually.
= Click OK

Baving your presentation

s Save your
presentation by
clicking Office
Button and then g u. o  mmne
T T

[ PRINTING HANDOU

= 1- In the print menu select
Print What:Box and
change Slides to Handouts

» 2-inthe activated
Handouts section Use the
Slides per page box to
control count of the slides
that will printed on the

page.

» 3- Use the Order checkbox
to determine the page
order

.
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I. How would you rate the usefulness of the content?
(1 2 3 4 5)
3 2. How would you rate Presenters’ knowledge in the subject?
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3. How would vou rate the presenters’ style of teaching?
(1 2 3 + 5)
4. How would vou rate the pace of the presentation’?
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3. What did you like best or find useful in the presentation?
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c 28-8-2017

To | %
The Principal, '
CMRCET, %, )
Kandlakoya, X T )

’Lf s
Hyderabad, “pndal, ¥
501401. '
Dear Sir,

Sub: Appreciation on behalf of ZPHS, Ravalkole— Reg.

I take this opportunity to express thanks to Naipunya Club, CMRCET for delivering a 1 day
session “Guest lecture on Introduction to PowerPoint Presentation” on 26-8-2017. | extend

heartfelt thanks to the speakers of the guest talk.

Thanking you,

ZPHS,

Ravalkole,

fMadchal Manaa



CMR COLLEGE OF ENGINEERING & TECHNOLOGY
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( ) Approved by AICTE New Delhi, Permanently affillated to INTUH
’:':m i Accredited by NAAC with ‘A’ Grade, All B.TechProgrammes Accredited by NBA

Kandlakoya (V), Medchal Road, Hyderabad -501401.

Date: 08:09-2017

To
The Principal,
CMR College of Engineering & Technology,
Hyderabad.

Through: Coordinator, IQAC- CMRCET.
Respected sir,
Subject: Approval for organizing hands on session on House wiring and Repair— Reg.

As per the discussion held with the Sarpanch of Pudur and Ravalkole the unemployed youth are
in need of hands-on session for enhancing their employability skills. As such we are planning to conduct
a hands-on session on “House wiring & Repair” for three days i.e. from 09-09-2017 to 11-09-2017 in
our college premises under "NAIPUNYA CLUB". This workshop as it creates awareness about electrical
safety measures and practical approach on basic house wiring and techniques.

Resource person for this training is Dasari Ajay Associate Professor Mechanical Department,
CMRCET.

The topics to be covered are hereby enclosed.

In this regard of concern kindly accept the proposal and provide the resources.

S.NO Name of the component Quantity(NO)
01 Tube lights & Bulbs 10 Each
02 Choke coils 110
03 Two way switches & one way switch 10 Each
04 MCB s & Plug sockets 10 Each
05 Connecting wires 30mts
, g et 2 s

CMRCET.



Y CMR COLLEGE OF ENGINEERING & TECHNOLOGY

@ (UGC AUTONOMOUS)
! Approved by AICTE New Delhi, Permanently affiliated to INTUH
B Accredited by NAAC with ‘A’ Grade, All B.TechProgrammes Accredited by NBA
; Kandlakoya (V), Medchal Road, Hyderabad -501401.
Day 1
TIME TOPICS
10:00am- Introduction importance of House writing
11:30am
11:30am — 11:45am
Break
11:45am - Selection of elements & Components for House writing
1:15Pm
1:15pm — 2:00pm
Lunch
2:00pm — Types of switches Isolators & circuit Breaks Fuses
4:00pm
Day 2
10:00am — Selection of wires & Importance & general methods (Electrical methods)
11:30am
11:30am — 11:45am
Break
11:45am - Lab visit: Types of symbols and their identifications
1:15pm
1:15pm — 2:00pm
Lunch
2:00pm — Basic switch connections
4:00pm One comp controlled
Two Lamps controlled by one-way switch
One lamp controlled by 2-watt switches
R e | Day 3
9:00am | Fan connections & repair
A100am
11:00am Repair & Maintenance
1:00pm
1:00pm — 1:30pm
: T Lunch Break
1:30pm Hands on fitting & their Hands-on fitting & Their Types
3:00pm &5 5 £V
3:00pm Conduction & Vote of Thanks
4:00pm
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Report on Hands on “House Wiring and Repair”
Under
Naipunya
Date: 09-09-2017 to 11-09-2017,
Time: 9 am to 4.00 pm

Venue: CMR College of Engineering & Technology
Topic: House Wiring and Repair
Hands-on session on House wiring and repair for employees and unemployed youth
Details of Speaker: Dasari Ajay

Event report: IQAC have organized a hands-on program for Unemployed youth of Ravalkol village and as
a part of it House wiring and repair was taught to them. The entire hands on was scheduled for three
days session conducted by Dasari Ajay.

The program is divided into nine parts:

Introduction importance of House writing

Choosing of elements & Components for House writing
Types of switches Isolators & Circuit Breaks Fuses
Selection of wires & its Importance

Lab visit: Types of symbols and their identifications

Basic switch connections (One comp controlled, Two Lamps controlled by one-way switch, One
lamp controlled by 2-way switches)
Fan connections & repair

8. Repair & Maintenance
9. Hands on fitting & their Hands-on fitting & Their Types

el ol

s

No. of Student attended the session 07

Feedback: As per discussion with the people involved in the session, the topic covered was appreciated
by most of the students and requested to arrange such hands on with advancements in the future also
Course outcome : To analyze the basic connections and the operation with switches and isolators under
different conditions.
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Report on Hands on “House Wiring and Repair”
Under
Naipunya
Date: 09-09-2017 to 11-09-2017,
Time: 9 am to 4.00 pm

Venue: CMR College of Engineering & Technology
Topic: House Wiring and Repair
Hands-on session on House wiring and repair for employees and unemployed youth
Details of Speaker: Dasari Ajay

Event report: IQAC have organized a hands-on program for Unemployed youth of Ravalkol village and as
a part of it House wiring and repair was taught to them. The entire hands on was scheduled for three
days session conducted by Dasari Ajay.

The program is divided into nine parts:

Introduction importance of House writing

Choosing of elements & Components for House writing
Types of switches Isclators & Circuit Breaks Fuses
Selection of wires & its Importance

e T e

Lab visit: Types of symbols and their identifications

6. Basic switch connections (One comp controlled, Two Lamps controlled by one-way switch, One
lamp controlled by 2-way switches)
Fan connections & repair

Repair & Maintenance
Hands on fitting & their Hands-on fitting & Their Typoe

No. of Student attended the session 07

Feedback: As per discussion with the people involved in the session, the topic covered was appreciated
by most of the students and requested to arrange such hands on with advancements in the future also
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@% CMR COLLEGE OF ENGINEERING & TECHNOLOGY

8 (AUTONOMOUS)
CMR NAAC Accredited Institution with ‘A’ Grade
e e Kandlakoya (V), Medchal Road, Hyderabad -501401.
Date: 25-09-2017

To
The principal,
CMR College of Engineering & Technology,
Hyderabad.

Through: Coordinator, IQAC, CMRCET.
Respected sir,

Subject: Approval for organizing a 3-day training program on Welding for unemployed youth of nearby
villages — Reg.

With reference to the telephonic conversation with Pudur and Rajabollaram village Sarpanch,
NIPUNYA Club is planning to organize a “3-day training program on Welding” for unemployed
youth of nearby villages from 14-10-2017 to 16-10-2017 at CMR College of Engineering &
Technology.

The objective of this training is to develop the skill set on welding and encourage towards self
employment or work position in any industry.

Proposed resource person for this training is Mr. E. Sammaiah, Assistant Professor, Mechanical
Engineering, CMRCET. To organize this training program, resources of Engineering Workshop Lab
are required. Materials and tools required are attached herewith.

I request you to kindly accept the proposal and provide the resources.

/Q-\CO * sl /'\O\.\\'q Dr%Rao

Convener - Naipunya Club
Dr. A KOTISHWAR CMRCET

Mdmw
Dept. of Master of Business Administration

(MR Coflege of Engineering & Technology
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“ &\‘ (AUTONOMOUS)
P R NAAC Accredited Institution with ‘A’ Grade

A o Adint Kandlakoya (V), Medchal Road, Hyderabad -501401.

Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017
CONTENT
1. INTRODUCTION

2. SAFETY IN WELDING
a. Personal protection
b. Work site protection
c. Welding fumes
d. Safety check list

3. SOLUTIONS
a. Quick guides to processes
b. Metal identification

) ¢. Unalloyed / low alloyed steel

d. Copper and copper alloys
e. Evaluation of welds

4. CONSUMABLES
a. Coated Electrodes
b. Wires for Wire Welding
c¢. Gas Welding Rods & Fluxes

5. ARC WELDING PROCESS & EQUIPMENT
a. Electrode welding

6. GAS WELDING AND CUTTING PROCESS & EQUIPMENT
a. Current Distribution System
b. AC/OX cutting, welding, brazing
c. Gas Supplies and gas distribution system

COURSE OUTCOME
1. Carry out routine jobs of setting the machine and components for cutting, welding, brazing and
l ) allied operations.
2. Perform practical skills to cut/ weld metal pieces in different positions by using, Gas welding,
with appropriate equipments/ consumables and ensure quality weld joints.
3. Perform manual Gas cutting operation for carrying out repair works or stock removal.
4. Perform joining of metals by brazing process to the reql_Jired quality.
5. Perform practical skills to prepare and weld metal pieces in different positions by using Arc
welding, with appropriate equipments/ consumables and ensure quality weld joints.
6. Perform inspection of welded joint by visual inspection, and measure weld parameters using
weld gauges.
J/j// 52

PRINCIPAL
LEGE OF ENGG. & TECH.
V), Medchal Road,
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CMR COLLEGE OF ENGINEERING & TECHNOLOGY

(AUTONOMOUS)
NAAC Accredited Institution with ‘A’ Grade
Kandlakoya (V), Medchal Road, Hyderabad -501401.

Skill Development Program on Welding
Under

UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM

Date: 14-10-2017 to 16-10-2017

TOOLS AND EQUIPMENTS
S.No. Description of tools QTY
List of Hand Tools
1 Hand Gloves pair leather 10
r Apron leather 10
3 Goggles pair with welding coloured glass 10
4 Centre punch 4
5 Dividers 4
6 Caliper outside 4
t 3 7 Steel rule 300 mm with metric and inches scale B
8 Wire brush (M.S & SS) 8
9 Spark lighter 8
10 Scriber 8
11 Tongs holding300 mm 5
12 Welding helmet type with filter glasses 10
13 Chipping hammer 5
List of Shop Outfit
14~ | Hammer ball pen 5
15 Hacksaw frame 10
16 File flat bastard 5
17 Spanner set 1 set
18 Outfit spanner & spindle key for Gas welding outfit 1 set
19 Work bench fitted 4 Bench vices 1
20 Screw Driver set 1
21 Hammering blocks 5 ¢m thick 60 sq.cm 1
RE 22 Gas welding table with fire bricks 1
23 Gas cutting table with debris tray _ 1
o Arc welding table with protected weld filter glass/fire proof screens 1
Oxy-Acetylene Gas welding and cutting plant mounted on trolley with
25 OxyAcetylene Gas cylinders, pressure regulators, hose connections, gas
welding torch with nozzle No.l & 2,3 & 5 and Gas cutting torch with 1.2
&1.6 mm nozzles. 2 units
26 Transformer welding set with all accessories 300 A 2 units
27 Arc welding set DC, Rectifier or Inverter type, 300 Amps with all
accessories 2 units
- Consumables, Oxy-acetylene Gases, raw materials, fluxes and filler wires. As requires
29 Fire Fighting equipment As requires

AP

PRINCIPAL
EGE OF ENGG. & TECH.
(V), Medchal Road,

bad-501401.
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L CMR COLLEGE OF ENGINEERING & TECHNOLOGY

> (AUTONOMOUS)
NAAC Accredited Institution with ‘A’ Grade
e Kandlakoya (V), Medchal Road, Hyderabad -501401.
Date: 27-09-2017
From
Principal -

CMR College of Engineering & Technology
Kandlakoya(V), Medcha Road,
Hyderabad — 501401

To
The Sarpanch

Subject: “Request for Heraldic in your village for 3-day Skill development program on Welding”- Reg

For the benefit of unemployed youth, our campus is planning to conduct a 3-day skill
development program on welding is to be held from 14-10-2017 to 16-10-2017. I request you to heraldry
in your village and encourage the unemployed youth to participate in the skill development program on
welding.

Major Dr. V. A. Narayana
Principal

PRINCIPAL

Hyderabad-501401.

J’/,/ s

/

PRINCIPAL
LEGE OFENGG. & TECH.
V), Medchal Road,

1401.

CMR COLLEGE OF ENGG. & TECH.
Kandlakoya (V), Medchal Road,
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al#  CMR COLLEGE OF ENGINEERING & TECHNOLOGY

i M (AUTONOMOUS)
R NAAC Accredited Institution with ‘A’ Grade
BRELORLTD NPT y Kandlakoya (V), Medchal Road, Hyderabad -501401.
Date: 27-09-2017
From
Principal

CMR College of Engineering & Technology
Kandlakoya(V), Medcha Road,
Hyderabad - 501401

To
The Sarpanch
f £

Subject: “Request for Heraldic in your village for 3-day Skill development program on Welding”- Reg

For the benefit of unemployed youth, our campus is planning to conduct a 3-day skill
development program on welding is to be held from 14-10-2017 to 16-10-2017. 1 request you to heraldry
in your village and encourage the unemployed youth to participate in the skill development program on

welding. -

A
o Major Dr. V. A. Narayana
LA Principal

. PRINCIPAL

o CMR COLLEGE OF ENGG. & TECH.
Kandlakoya (V), Medchal Road,

o Hyderabad-501401.
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PRINCIPAL
FGE OF ENGG. & TECH.
(V), Medchal Road,
ad-501401.

PRINCIPAL ;
GE OF ENGG. & TECH.
/). Medchal Road,

2d-501401.



\.’ CMR COLLEGE OF ENGINEERING & TECHNOLOGY

m (AUTONOMOUS)
NAAC Accredited Institution with ‘A’ Grade

EXPLONETOWVENT Kandlakoya (V), Medchal Road, Hyderabad -501401.

Date: 27-09-2017

From

Principal

CMR College of Engineering & Technology

Kandlakoya(V), Medcha Road, N
Hyderabad - 501401

To
The Sarpanch

Cunivabed)

Subject: “Request for Heraldic in your village for 3-day Skill development program on Welding”- Reg

For the benefit of unemployed youth, our campus is planning to conduct a 3-day skill
development program on welding is to be held from 14-10-2017 to 16-10-2017. I request you to heraldry
in your village and encourage the unemployed youth to participate in the skill development program on

welding.

' —~ Major Dr. V. A. Narayana

ASE * Principal
“\\._ = '\\. L i /!l 1 g PmClPAL
2o Aot ) CMR COLLEGE OF ENGG. & TECH.
P Kandlakoya (V), Medchal Road
Hyderabad-501401.

T
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W2 CMR COLLEGE OF ENGINEERING & TECHNOLOGY

en. (AUTONOMOUS)
MR NAAC Accredited Institution with ‘A’ Grade
P Kandlakoya (V), Medchal Road, Hyderabad -501401.
Date: 27-09-2017
From
Principal

CMR College of Engineering & Technoldgy
Kandlakoya(V), Medcha Road,
Hyderabad — 501401

To
The Sarpanch

(Pud ey )

Subject: “Request for Heraldic in ybur village for 3-day Skill development program on Welding”- Reg

For the benefit of unemployed youth, our campus is planning to conduct a 3-day skill
development program on welding is to be held from 14-10-2017 to 16-10-2017. I request you to heraldry
in your village and encourage the unemployed youth to participate in the skill development program on

welding.

271
Major Dr. V. A. Narayana
ENGy Principal

St CMR COLLEGE OF ENGG. & TECH.
4 Kandlakoya (V), Medchal Road,

_\ i ' PRINCIPAL

*f

¥ f\\(--t"‘,‘

S Hyderabad-501401.
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\.ﬂ CMR COLLEGE OF ENGINEERING & TECHNOLOGY

i a/r (AUTONOMOUS)
" 1 R NAAC Accredited Institution with ‘A’ Grade
' FETLAETR N Kandlakoya (V), Medchal Road, Hyderabad -501401.
Date: 27-09-2017
From
Principal

CMR College of Engineering & Technology
Kandlakoya(V), Medcha Road,
Hyderabad — 501401

To

The SaEanch

Subject: “Request for Heraldic in your village for 3-day Skill development program on Welding”- Reg

§ For the benefit of unemployed youth, our campus is planning to conduct a 3-day skill
development program on welding is to be held from 14-10-2017 to 16-10-2017. I request you to heraldry
in your village and encourage the unemployed youth to participate in the skill development program on
welding.

1)
Major Dr. V. A. Narayana
Principal
e L) PO PRINCIPAL
1S \ mit L
B3 Kandiakoya (V). Mot el
N

Jé’//

-—

PRINCIPAL

'GE OF ENGG. & TECH.
1 (V), Medchal Road,
erabad-501401.



| CMR COLLEGE OF ENGINEERING & TECHNOLOGY
(AUTONOMOUS)
R NAAC Accredited Institution with ‘A’ Grade
SHABRTO e Kandlakoya (V), Medchal Road, Hyderabad -501401.

Report on
Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017
Time: 9:30 am to 4.00 pm
Venue: CMR College of Engineering & Technology

Event report:

NIPUNYA club has organized a unemployed youth skill development program on welding to the
unemployed youth of nearby villages. The main objective of this training is to focus on training the
unemployed people towards increase in their chance of employment.

In these three days the trainees are explained by Arc Welding Process & Equipment, Gas Welding and
Cutting Process & Equipment and safety measures.

At the time of visit to the lab we expléined the practical parts of welding machines and the mechanisms
were shown to them.

Then we showed how to work on welding machines with safety precautions. They were given by desngns
of work to be turned and under the guidance of lab assistants the operations were conducted.

No. of Participants attended the session: 10

Venue: Engineering Workshop, CMRCET

Outcome: Perform practical skills to cut/ weld metal pieces in different positions by using, Arc,
Gas welding.
Overall Feedback: As per feedback given by the people involved in the session, the topic covered was

appreciated by most of the participants and overall they rated the training session as 4 out of 5 , also
requested to arrange such hands on with advancements in the future also.

Dr. J. Srigjvasa
Convener - Nai
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C CMR COLLEGE OF ENGINEERING & TECHNOLOGY

(AUTONOMOUS)

; R NAAC Accredited Institution with ‘A’ Grade
peab el Kandlakoya (V), Medchal Road, Hyderabad -501401.

Skill Development Program on Welding

Under

UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017

Program Schedule:
Day 1: 14-10-2017

Forenoon: 9:30 AM to 12:30 AM
1. Introduction to Welding

2. Safety in welding

Lunch: 12:30 PM to 1:30 PM
After noon: 1:30 PM to 4:00 PM

1. Quick guides to processes

2. Metal identification

3. Unalloyed / low alloyed steel
4. Copper and copper alloys

5. Evaluation of welds

Day 2: 15-10-2017
Forenoon: 9:30 AM to 12:30 AM

1. Arc Welding Process

Lunch: 12:30 PM to 1:30 PM
After noon: 1:30 PM to 4:00 PM

1. Hands on session on arc welding

Day 3: 16-10-2017
Forenoon: 9:30 AM to 12:30 AM

1. Gas welding process

Lunch: 12:30 PM to 1:30 PM

After noon: 1:30 PM to 4:00 PM
I. Hands on session on gas welding

(3oh H8H0)
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CMR COLLEGE OF ENGINEERING & TECHNOLOGY
(AUTONOMOUS)
NAAC Accredited Institution with ‘A’ Grade
e i) Kandlakoya (V), Medchal Road, Hyderabad -501401.

Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017

Photos Related to the event:




& CMR COLLEGE OF ENGINEERING & TECHNOLOGY

(AUTONOMOUS)
R NAAC Accredited Institution with ‘A’ Grade
5 Kandlakoya (V), Medchal Road, Hyderabad -501401.

Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017

Attendance sheet:

A Signature D230
S.No Name Village Day 1 Day 2 e
I Powi Aduy” - g (i
2 Namesh  Gundipet A % X/
3 ?ﬁ@éb k“mg - e w ~
4 7/ Loadout /g:j; " - o e
5 Weqo Pesr Priy’ corn e st
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7 Malish Perd ur v i ¥
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9 e Dodor g fleviaum — e ——
10 | Mallzaah Ditdur v v gt
11 Lol Lingh 220 7 — [
12 Sounsay Sivah Dutcdesr” V” — o
13 g v / r
14
15
16 &
17
18
19
20
21
22
23
24
J 25
26

Dr. J. Srikivasa-Rao
Convener - Naiplinya Club
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R CMR COLLEGE OF ENGINEERING & TECHNOLOGY
(AUTONOMOUS)
YL NAAC Accredited Institution with ‘A’ Grade
TR s Kandlakoya (V), Medchal Road, Hyderabad -501401.

Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017

Feedback form:

1. The workshop venue was: Strongly disagree — strongly agree
S0 : 13 eofiE8oudh - NP ewofifo)mm) &
Comfortable (58§05 T0) 1 2 3 4 @
Well located (2071 SO8) Gl 3 @ 5

2. The workshop content was
3B S0
a) Relevant (002005 ¢b) 1 2 @ 4 5
b) Comprehensive (o9 1 2 3 @ 5
¢) Basy to understand (@0 B850 0ex2s0) 1 2 3 @ 5

3. The facilitators were

220D FS0 1 2 @ 4 5

4. What did you like the most about the training session?
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L CMR COLLEGE OF ENGINEERING & TECHNOLOGY

?- (AUTONOMOUS)
A R NAAC Accredited Institution with ‘A’ Grade
e Kandlakoya (V), Medchal Road, Hyderabad -501401.

Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017

Feedback form:
1. The workshop venue was: Strongly disagree — strongly agree
SBar K563 eoA¥BOST S - K eohEBiymr) &
Comfortable (R*E855050) Tiaoe Sh e gl
Well located  (23°T° GOO) 1 . .3 § ol
2. The workshop content was
3BparD 00
a) Relevant (0205 ¢b) 1 2 3 v
i} b) Comprehensive (fe|({S) 1 2 § ATk
‘ ¢) Easy to understand (€80 T80 0ex250) 1 2 § il =
3. The facilitators were
ROBY S0 1 2 e sy

4. What did you like the most about the training session?
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C R NAAC Accredited Institution with ‘A’ Grade

Kandlakoya (V), Medchal Road, Hyderabad -501401.

Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017

Feedback form:

1. The workshop venue was: Strongly disagree — strongly agree
:)52,3.‘5) He3rr wofi¥B8ouE e - KM eo¥dm) &
Comfortable (*EE5905IN) 1 2 3 4
Well located (23°1° GOD) 1 2 3 4

2. The workshop content was
5B xre 0B
a) Relevant (020085¢b) I 2 3 4
b) Comprehensive (cdod| ) ' 1 W G o
¢) Easy to understand (@30 B0E'SG0 0exzso) 1 2 3 4

3. The facilitators were

OB S0 1 F ST R

4. What did you like the most about the training session? g
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# NAAC Accredited Institution with ‘A’ Grade
paE Ie e Kandlakoya (V), Medchal Road, Hyderabad -501401.
Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017
Feedback form:
1. The workshop venue was: Strongly disagree — strongly agree
SBLXD 163 eoA¥BOSE: - K3 woREBHa &
Comfortable (885505 J) 1 2 3 @ 5
Well located (2°1° G00) 1 2 4 5
2. The workshop content was
SBare SoBodd
a) Relevant (002208 ¢b) 1 2 3 a 5
by b) Comprehensive (ed|((9) 1 2 @ 4 5
¢) Easy to understand (€980 T80 0ex250) 1 2 3 @ 5
3. The facilitators were
20T S0 TN ¥t @

4. What did you like the most about the training session?
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Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017

Feedback form:

1. The workshop venue was: Strongly disagree — strongly agree
bt o Zrﬁ"':) %3 eoA¥BouB L - K ewof¥Bd)m )&
Comfortable (D*E555050) 1 = s @
Well located (23T SOO) 1 2 3 @ ®

2. The workshop content was
358D $o®osS
a) Relevant (02008 ¢%) 1 2 3 % 5
b) Comprehensive (2o2({S) 1 2 3 5
¢) Easy to understand (€930 BEI%0 e20) 1 2 3 5

3. The facilitators were

2ROHOE S0 booa Tk

4, What did you like the most about the training session?
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Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017

Feedback form:

1. The workshop venue was: Strongly disagree - strongly agree
&562,@'[;) He3mr @ofi8od B - KB ewo¥d8)T ) &
Comfortable (RrE5$5085T) ey s e
Well located (21T &5OQ) ST S SRS

2. The workshop content was
5B)xD 0B
a) Relevant (Q00208€) 1 2 3 4
b) Comprehensive (cde| () 1 2 3 4

¢) Easy to understand (&30 T80 ex2so)

3. The facilitators were

OB Fdo 1 2 3 4
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4. What did you like the most about the training session?
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il Kandlakoya (V), Medchal Road, Hyderabad -501401.

Skill Development Program on Welding

Under

UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017

Feedback form:
1. The workshop venue was: Strongly disagree — strongly agree
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Well located (251 &500)

2. The workshop content was
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a) Relevant (D02005¢H)
! b) Comprehensive (daD|(f)
; ¢) Easy to understand (€30 Te08’3¢80 0exeso)

3. The facilitators were
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4, What did you like the most about the training session?
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C R NAAC Accredited Institution with ‘A’ Grade
e et Kandlakoya (V), Medchal Road, Hyderabad -501401.

Skill Development Program on Welding

Under

UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM

Date: 14-10-2017 to 16-10-2017

Feedback form:
1. The workshop venue was: Strongly disagree — strongly agree
8562,-5?1‘{) 5e3rr wofi¥Boueleh - & wofiEdar ) %

Comfortable (EE5505R0)
Well located (23°M™ &OD)

2. The workshop content was
382X 00
a) Relevant (020085ed)
b) Comprehensive (fe0|(%)
¢) Easy to understand (&30 T80 ex2io)

3. The facilitators were

OB TS0

4. What did you like the most about the training session?
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‘ CMR COLLEGE OF ENGINEERING & TECHNOLOGY
CMR

Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017

Feedback form:

1. The workshop venue was: Strongly disagree — strongly agree
«:)52,3:1‘5) H&3mr wofi¥Bos S - el ewof¥8iar)y &
Comfortable (R*EE55050) 1 3 4 5
Well located (23*1™ &O&) 1 2 3 @ 5

2. The workshop content was
SBarD 00
a) Relevant (D0200&¢$) 1 2 %40 35
b) Comprehensive (cde0|() 1 2 3 4 B
¢) Easy to understand (&30 T083¢80 ezso) 1 2 3 @ 5

3. The facilitators were

OB Fdo 1 2 3 4
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4. What did you like the most about the training session?
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Skill Development Program on Welding
Under
UNEMPLOYED YOUTH SKILL DEVELOPMENT PROGRAM
Date: 14-10-2017 to 16-10-2017

Feedback form:

1. The workshop venue was: Strongly disagree — strongly agree
:362,:1‘1:) He3mr @ofiEBoddth - Y wofidar) &
Comfortable (8B 5905 I0) 1 2 4 5
Well located (23 &0O8) 1 2 4 5

2. The workshop content was
5B §0B0E
a) Relevant (D0205¢€) 1
b) Comprehensive (ce|) 1
¢) Easy to understand (&80 T80 exzso) 1

3. The facilitators were
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4. What did you like the most about the training session?
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CMR COLLEGE OF ENGINEERING & TECHNOLOGY

MR (AUTONOMOUS) B
C NAAC Accredited Institution with ‘A’ Grade

EXPLORE TO vENT Kandlakoya (V), Medchal Road, Hyderabad -501401.

Date: 04-01-2018
To

The Principal,

CMR College of Engineering & Technology,
Hyderabad.

Through: Coordinator, IQAC, CMR College of Engineering & Technology.
Respected sir,

Subject: Request to organize a “Briefing session on Introduction to Computers” for students of Upper

Primary School, Rajbollaram — Reg.

H As per the discussion and request received from Head Master, Upper Primary School,
Rajbollaram, it is to bring to your kind notice that NAIPUNYA Club is planning to organize a “Briefing
sessionon Introduction to Computers” for IX class students, on 3-2-2018 at Upper Primary School,

Rajbollaram. The main objective of this lecture is to enhance the skill set of the school students.

Proposed resource persons for this training are:

S.No | Student Name Roll No Branch | Year
1 BANDARU BALRAJ 15H51A0507 | CSE I
2 YENCHURALA ALEKYAREDDY | I5H51A05J0 | CSE I
3 YEJELLA RAMYA SREE 15H51A05P8 | CSE I
4 RATHNALA RAJU 16H55A0437 | ECE 111

[

The objectives of the guest lecture are, to make students to

o Examine the fundamentals of computers’ ‘///_’

» [llustrate the functionalities of computers
A\
o Classify the applications of computers )
v
Kindly accept the proposal for the smooth conduct of the sessi
™\ 2comen<ed
] \rfc:,_ ’_/——-"
_— Convener - Naipunya Club
(® Y\/\ \ ‘( [CH CMRCET
A\
max@}-&u\ .
L MPAL, PAD.
Head of the Department
Dept. of Master of Business Administration



CMR COLLEGE OF ENGINEERING & TECHNOLOGY

@ C MR (AUTONOMOUS)

NAAC Accredited Institution with ‘A’ Grade
i e Kandlakoya (V), Medchal Road, Hyderabad -501401.

06-01-2018
Hyderabad

To
Head Master,

_ Upper Primary School,
Rajbollaram
MEDCHAL.

Sir,

t Sub: Interested to conduct a 1-day Guest Lecture on “Briefing session on Introduction to Computers”

for students of Upper Primary School, Rajbollaram by CMRCET B. Tech students -Regarding

With reference to the above cited subject, and as per the earlier telephonic conversation we had, I bring
to your kind notice that students of CSE and ECE of CMRCET are interested in conducting a guest
lecture session to the students of Upper Primary School, Rajbollaram. With the help of this session, your

students will be able to understand the basics of computers.

In this regard, I request you to provide an opportunity for our students and please provide the proper
classroom, basic facilities to our students.

Y

} -

OF FArxs
(! /
[

Major. Dr. V. A. Narayana

' ‘AR i Principal
/ . =50/ CMRCET
// W PRINCIPAL

CMR COLLEGF ' ENGG. & TECH.
Kandlakoya (\'} tizdchal Road,
HyderaLad-501401.



REPORT:

Topic: Briefing session on Introduction to Computers
Venue: Upper Primary School, Rajbollaram
Date of session: 3-2-2018

List of students deputed for the session:

Conducted By: “Naipunya Club”, CMR College of Engineering & Technology.

S.
e Student Name Roll No Branch | Year
0
1 BANDARU BALRAJ 15H51A0507 CNE -1 1
2 | YENCHURALA ALEKYAREDDY | 15HS51A05J0 CSE I
3 YEJELLA RAMYA SREE ISH51A05P8 CSE 111
4 RATHNALA RAJU 16H55A0437 | ECE | 1
Key Points covered:

e Computer basics
¢ Functions of computers
e Applications of computers

¢ Generations of computers

Participants: 25

Outcome: Students are able to evaluate between different types of computers and

its peripherals.
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Introduction to Computers

L

Computer Fundamentals

A computer 1s an electronic data processing
device, wrich accepts and stores data input,
processes the data input, and generates the
oulputin & required format

Functionalities of a Computer

» e ook al o a very broad sense, any digital
uter ( oul the following five functions

® Slep 1 - Tak tala as input

s Slep 2 - Sk the data/instructions in its memory and

w them o required

s Slop G Prooosses'the data and converts it into useful
fahior

a Stepd - Ge ates the output

miSer 5 il the above four steps

g

Advantages of Computers

= High Speed

m Accuracy

= Storage Capability

= Diligence

= Versatility

= Reliability

m Automation

= Reduction in Paper Work and Cost

Disadvantagesof Computers
= Dependency

= Environment
= No Feeling

* SRS
Application of computers

Business

Banking

Insurancao
Education
Marketing
Healthcare
Engineernng Design
Military
Communication

Government

o

\GG. & TECH.
al Road,
101,



Computer Generations
There aro five computer generalions known till date

1 First Generation The period of first generation: 1946-1959. Vacuum
tub:: based

2 Second Gene:ranon The period of second generation: 1959-1965.
Transistor based

3 Thud Generation The period of third generation: 1965-1971
Integrated Circudt based.

4 Fourth Generation The period of fourth generation: 1971-1980.
V1 81 microprocessor based i

5 Fiftn Generation The period of fifth generation: 1980-onwards. ULS
MHCTOPIOCessr based

Thank you

e

PRINCIPAL

YVLLEGE OF ENGG. & TECH.
Medchal Road,

H}-u;igoau-501401.



BRIEFING SESSION ON
INTRODUCTION TO COMPUTERS

Date: 3-2-2018

S.No Name Signature
I Berarika, ; Bet vnika_
2. L kitm Likitn,
3. Kaiix Rayu
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: 3 &
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BRIEFING SESSTION ON

INTRODUCTION TO COMPUTERS

Date: 3-2-2018

S.No Name Signature
% chandu chesde~
% Mouwnika Mounille-
8. (oS (58
49 60?'1 3-43;
<D Bhose o Eheraihh Bhav,
s How, babia P, b
] o o/
24 Mo Mowgon -
- _Publiceva el
) - Kave yd ko r
26 Nelotfce Nelo




FEEDBACK FORM

Title: Briefing on Introduction to Computers

e
1 - Very Poor 2 — Poor 3 — Average 4 - Good 5 - Excellent

(i

How would you rate the usefualness of the content?
A 3 X5

How would you rate Presenters” knowledge in the subject?
2 3 4 Ly

How would you rate the presenters’ style of teaching?

(1 2 3 4 S)

How would you rate the pace of the presentation?

(Too fast oo slow Jast right)

What did you like best or find useful in the presentation?

Date: 3-2-2018



FEEDBACK FORM

Title: Briefing on Introduction to Computers
I - Very Poor 2 — Poor 3 — Average 4 —~ Good 5 - Excellent
. How would you rate the usefulness of the content?

TS e SR TR

How would you rate Presenters” knowledge in the subject?
s A 3 4 ay
Hovs would you rate the presenters’ style of teaching?

EeLdE S C:U 5)

4. How would you rate the pace of the presentation?

SR i .
(Too fast — ( Too slow Just right)

What did you like best or find useful in the presentation?

s ]

Date: 3-2-2018



FEEDBACK FORM

Title: Briefing on Introduction to Computers

1 — Very Poor 2 — Poor 3 — Average 4 — Good 5 - Excellent

I

o

3-

How would you rate the usefulness of the content?
e Sl e g
How would you rate Presenters’ knowledge in the subject?

TR RS T iy

How would you rate the presenters’ style of teaching?
¢ I SRR iR 5)

How would you rate the pace of the presentation?

(Too fast  Too slgw—" Just right)

What did you like best or find useful in the presentation?

' T?@od’ |

PRINCE 6.8
yF ERNY o
c(E OF nal RO3Y:
un COLLY ?.\f‘\"‘d"n.'.a}\ ik
: AakO b 140
Kar .1\?7 MLJdd‘JO\
) A

Date: 3-2-2018



FEEDBACK FORM

Title: Briefing on Introduction to Computers
1 — Very Poor 2 — Poor 3 — Average 4 — Good 5 - Excellent
1. How would you rate the usefulness of the content?
L B T @
z. How would you rate Presenters’ knowledge in the subject?
(1 2 3 @ T
5. How would you rate the presenters’ style of teaching?
(1 2 = 5)
4. How would you rate the pace of the presentation?
(Too rast loo slow™  Just right)

W iml did you like best or find useful in the presentation?

osgtal]

Date: 3-2-2018



FEEDBACK FORM

Title: Briefing on Introduction to Computers
1 - Very Poor 2 — Poor 3 — Average 4 - Good 5 - Excellent

I. How would you rate the usefulness of the content?
@ 2 3 4 5)
2. How would you rate Presenters’ knowledge in the subject?

( @ e

How would you rate the presenters’ style of teaching?

i 2w 4 5)

4. How would you rate the pace of the presentation?
(Too fast oo slow  Just right)

What did you like best or find useful in the presentation?

Gond |
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t ’ ¥ E"\(‘(; I\Hoa 1
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H-\‘KR\ it N el 1
'-"" AlakCya ) [—'O-\AO
Kanaid JJj o
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FEEDBACK FORM
Date: 3-2-2018
Title: Briefing on Introduction to Computers
1 - Very Poor 2 ~ Poor 3 — Average 4 — Good 5 - Excellent

. How would you rate the usefulness of the content?

i
(1 2 3 4 5)

2. How would you rate Presenters” knowledge in the subject?
| i IR SR
Hov would you rate the presenters’ style of teaching?
(1 2 3 4 5

<. How would you rate the pace of the presentation?
(Too fast l'oo slow Jbrst right)
What did vou like best or find useful in the presentation?

VA O'/




FEEDBACK FORM
Title: Briefing on Introduction to Computers

I How would you rate the usefulness of the content?
a4 2 3 4 5)

2. How would you rate Presenters” knowledge in the subject?
(1 2 3 4 :
How would you rate the presenters’ style of teaching?
(1 2 \/3 4 5)
Hov would you rate the pace of the presentation?

(Too fast Too slow Just right)\/

What did you like best or find useful in the presentation?

Peiey
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FEEDBACK FORM

Title: Briefing on Introduction to Computers
1 - Very Poor 2 -~ Poor 3 — Average 4 — Good 5 - Excellent
1. How would vou rate the usefulness of the content?
w2 3 4 3)
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6-2-2018

To

The Principal,
CMRCET,
Kandlakoya,
Hyderabad,
501401.

Respected Sir,

Sub: Appreciation note to your college students— Reg.

On behalf of Upper Primary School, Rajbollarum, I would like to thank CMR College of
Engineering & Technology for conducting 1- day program on “Briefing session on Introduction
to Computers” on 3-2-2018. The |- day program made our students to understand the basics of

computers. We also look forward for the future proposals for any programs with our school. Feel

free to contact for the same.

Thanking you,

L a s Headﬁ‘%{éﬂaster .
G e’ M.P.P.S. Rajabollaram Thancs,
L g Wedchal (M), Medehal-Malkaijgiri Dist
co\\‘ ™ Upper Primary
I o School
RajBollarum,

Medchal Dist.



Fﬁﬂ CMR COLLEGE OF ENGINEERING & TECHNOLOGY

(AUTONOMOUS)
. CMR NAAC Accredited Institution with ‘A’ Grade
e il Kandlakoya (V), Medchal Road, Hyderabad -501401.
Date: 23-02-2018
To
"The Principal,
CMR College of Engineering & Technology,
Hyderabad.

Through: Coordinator, IQAC, and CMRCET.

Respected sir,

Subject: Approval for organizing a 1-day Guest lecture on Magnetism and Faradays laws— Reg.

Venue: ZPHS, Pudur-Medchal.

@ As per the earlier discussion with the Head Master of ZPHS, Pudur, NAIPUNYA Club is planning to
organize a “1-day Guest lecture on Magnetism and Faradays laws” for IX class students, ZPHS, Pudur
on 3-03-2018 by students of CMR College of engineering and technology. The main objective of this
training is to create awareness among students about importance of Magnetic circuits and Faradays law.

Resource persons for this training program are IV year students of CSE, CMRCET.
1.14H51A05A0, PASAM RAJESWARI, B.TECH, CSE, IV
2.14H51A05E0, KANDALA GIRIDHAR REDDY, B.TECH, CSE, IV
3.14H51A05L2, JAMPALA NANDINI, B.TECH, CSE, IV
4.15H55A0506, RAGALA ARUN KUMAR, B.TECH, CSE, IV

The topics to be covered are Types of magnets, Behavior of conductor in Magnetic fields, Energy
Conversions.

Thanking you.

& Qx\éaa‘

x5
e

}

oo
2~

Dr. A. KOTIS! ":"';’Erj Dr. J'%ao

Professor & Hesd of the Department

Dapt. of ! r n vistration Convener,

1C > 0f tigiiee.aly % Technology Naipunya Club,
CMRCET.



é“ CMR COLLEGE OF ENGINEERING & TECHNOLOGY

. \d (AUTONOMOUS)
CMR NAAC Accredited Institution with ‘A’ Grade

i Kandlakoya (V), Medchal Road, Hyderabad -501401.

23-02-2018
Hyderabad

To

Head Master,
ZPHS, Pudur,
MEDCHAL.

Sir,

e Sir,

Sub: Willingness to conduct Guest Lecture on “Magnetism and Faradays laws” by CMRCET B. Tech
students -Regarding

As per the telephonic conversation we had and in connection to the above cited subject, I bring to your
kind notice that students of CSE from CMRCET are interested in conducting a guest lecture session to
the students of ZPHS Pudur. Our students are well versed with the Magnetism and Faradays laws and are
willing to take a session on the same to your students which will be good takeaway for the school

students.

In this regard, I request you to provide an opportunity for our students.

Major. Dr. V. A. Narayana ,

B Principal,
A - ~ CMRCET.
Ay g TE PRINCIPAL
\,\L\’\ﬁ% ﬁ\bc"&goad‘ CMR COLL_GL OCFENGG. & TECH.
EOE e ; Kand'ukova (V), Medchal Road,
T T Hyderabac-501401.
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GROUP OF INSTITUTIONS Report on Guest Lecture

EXPLORE TOINVENT

“On Magnetism and Faradays laws”
Under
NAIPUNYA Club
Date: Friday, 3 March2018
Time: 9:30 AM to 3.00PM
Venue: ZPHS school Pudur
A Guest lecture is held on “Magnetism and Faradays laws “for class X students of ZPHS Pudur by
1.14H51A05A0, PASAM RAJESWARI, B.TECH, CSE, IV
2.14H51A05E0, KANDALA GIRIDHAR REDDY, B.TECH, CSE, IV
3.14H51A05L2, JAMPALA NANDINI, B.TECH, CSE, IV
4.15H55A0506, RAGALA ARUN KUMAR, B.TECH, CSE, IV

To cultivate student learning and development by supporting students in their academic, personal, ard
social growth.

Topic: Electro Magnetics and Faradays law.

Event report: NAIPUNYA Club, have organized a Student development program for X class students of
Zillah Parishad High school (ZPHS) Pudur , In order to have an idea on the Magnetics and its conversion
of energies. Introduction about Magnets and its types

1. Solve Problemsabout Magnetic
2. Faradays Laws
3. Conversion of energies

Student’s Feedback: As per discussion with the students, the topic covered was appreciated by most ¢ f
the students and requested to arrange such talk in the future also

No. of Students attended the session 18

Attendance copy and photos are here by enclosed with this letter

Outcome: By the end of this lecture students should understand Magnetic flux, faradays law, th:
principles and laws of electromagnetic induction and Conversion of energies
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Under
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A Guest lecture is held on “Magnetism and Faradays laws “for class X students of ZPHS Pudur by
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social growth
Topic: Electro Magnetics and Faradays lav..

Event report: NAIPUNYA Club, have organized a Student development program for X class students of
Zillah Parishad High school (ZPHS) Pudur , In order to have an idea on the Magnetics and its conversion
of energies.

Introduction about Magnets and its type's

1. Solve Problems about Magnetic
2. Faradays Laws
3. Conversion of energies

Student’s Feedback: As per discussion with the students, the topic covered was appreciated by most of
the students and requested to arrange such talk in the future also

No. of Students attended the session 18

Attendance copy and photos are here by enclosed with this letter




ﬁ.ﬁ CMR COLLEGE OF ENGINEERING & TECHNOLOGY

C MR (AUTONOMOUS)
NAAC Accredited Institution with ‘A" Grade
LR AT Kandlakoya (V), Medchal Road, Hyderabad -501401
CONTENTS FOR
GUEST LECTURE ON
Introduction to Magnetism and Faradays Laws
INTRODUCTION:

While Oersted's surprising discovery of electromagnetism paved the way for more practical applications of
electricity, it was Michael Faraday who gave us the key to the practical generation of electricity: electromagnetic induction.
Faraday discovered that when he moved a magnet near a wire a voltage was generated across it. If the magnet was held
stationary no voltage was generated, the voltage only existed while the magnet was moving Faraday's Law of
electromagnetic induction The emf, \(\mathcal{E}\), produced around a loop of conductor is proportional to the rate of
change of the magnetic flux, ¢. through the area, A, of the loop. This can be stated mathematically as:\[\math cal{E} = -
Nifrac{\Delta\phi} {\Delta t}\]where \(\phi =B-A\) and B is the strength of the magnetic field. \(N\) is the number of eircuit
loops. A magnetic field is measured in units of teslas (T). The minus sign indicates direction and that the induced emf tends to

oppose the change in the magnetic flux. The minus sign can be ignored when calculating magnitudes.

AlIM:

To design a De motor with high speed and torque characteristics.

COURSE OUTCOMES:
By the end of this course, you should be able to:

» Define Magnetic flux

» State faradays law

» Demonstrate the principles and laws of electromagnetic induction
» Conversion of energies

y O 1 FGE OF ENGG. & TECH.
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5-3-2018

To

The Principal,
CMRCET,
Kandlakoya,
Hyderabad,
501401.

Respected Sir,

Subject: Thanks and Appreciation— Reg.

On behalf of ZPHS - PUDUR, I am very happy to express thanks to Naipunya Club for
conducting a 1-day talk on “Guest lecture on Magnetism and Faradays laws” on 3-3-2018. |
congratulate the student mentors for making the session fruitful. Our students understood the
concept of Magnestism and Faradays laws in a better manner. | request you to conduct similar

sessions on other important topics as well.

Thanking you,

BN Dist

ZPHS,
- Pudur
54//;
- ‘ﬁcﬂﬂ' R\
\‘\,%G"m:f;?" :S*R =
0 5 .
i
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CMR COLLEGE OF ENGINEERING & TECHNOLOGY
(AUTONOMOUS)
NAAC Accredited Institution with ‘A" Grade
Kandlakova (V), Medchal Road. Hyderabad -50 1407

Date: 16-03-2018

To

The Principal.

CMR College of Engineering & Technology.
Hyderabad.

Through: Coordinator, [QAC. CMRCET.
Respected sir,

Subject: Approval for organizing an “Awareness lecture on Preparation of Chemical Compounds™ for
VII class students. Pudur - Reg.

This is 1o bring to vour kind notice that as per the conversation with the Headmaster of Pudur
NAIPUNYA Club is planning to organize an “Awareness lecture on Preparation of Chemical
Compounds” for V1I class students. on 24-03-201% at ZPHS, Pudur. The objective of the guest lecture
is. to make students learn about the preparation of chemical compounds.

Resource persons tor this trainng are

L6HS TAOSDS J Ramya
[6GHSTAO4MO Mallela Harika
ISHS1AQ245 Rajesh Kumar Malinen
[SHSTAQO285 K Tejavardhan Yaday

= =

I also request you to provide the following lab equipment for this.
[. Salicylic acid

2. acetic anhydride

3. Concentrated FI2S0O4
4. 250 ml beaker

5. Heater

6. Glass rod

7. TFilter paper
| request you to Kindly accept you 1o accept the proposil.

VL?A
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g@ﬁ; CMR COLLEGE OF ENGINEERING & TECHNOLOGY

: 2 (AUTONOMOUS)
CMR NAAC Accredited Institution with ‘A’ Grade

T Kandlakoya (V), Medchal Road, Hyderabad -501401.

Date: 19-03-2018,
Hyderabad.

To

The Headmaster,
Pudur,

Medchal.

Respected Sir/Madam,

Sub: Request for resources to conduct an “Awareness lecture on Preparation of Chemical
Compounds™ for VII class students, on 24-03-2018 by CMRCET, B.Tech Students - Reg.

With reference to the above-cited subject, I bring to your kind notice that as per your request
students of CMRCET are interested to conduct an “Awareness lecture on Preparation of Chemical
Compounds” for VII class students, on 24-03-2018. With the help of this lecture, students will be able
to understand the Preparation of Chemical Compounds such as Aspirin.

In this regard, I request you to provide the following resources
1. A classroom to accommodate all the VII class students.
2. Power facility to demonstrate the experiment.
3. Table for experiment setup.

Thanking You.

»

i

\& 13

_ Major.Dr V A Narayana,
b ' Principal, .
SRIGRAL
~v+1 COLLEGE OF ENGG. & TECH.
. L ova (V). Miedchal Road,
o » jakoya (V). Medc
i ™ Hyderabad-501401.
i A\t
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E‘ﬁ CMR COLLEGE OF ENGINEERING & TECHNOLOGY

C & (AUTONOMOUS)
MR NAAC Accredited Institution with ‘A’ Grade

froertTemmn Kandlakoya (V), Medchal Road, Hyderabad -501401.

Date: 19-03-2018,
Hyderabad.

To

The Headmaster,
Pudur,

Medchal.

Respected Sir/Madam,

Sub: Request for resources to conduct an “Awareness lecture on Preparation of Chemical
Compounds” for VII class students, on 24-03-2018 by CMRCET, B.Tech Students - Reg.

With reference to the above-cited subject, I bring to your kind notice that as per your request
students of CMRCET are interested to conduct an “Awareness lecture on Preparation of Chemical
Compounds” for VII class students, on 24-03-2018. With the help of this lecture, students will be able
to understand the Preparation of Chemical Compounds such as Aspirin.

In this regard, I request you to provide the following resources
1. A classroom to accommodate all the VII class students.
2. Power facility to demonstrate the experiment.
3. Table for experiment setup.

Thanking You.

”

Major.Dr V A Narayana,
Principal,
SRIRCEAL
cr+n COLLEGE OF ENCG. &TECdH.
. -;.Jkoya (V). Iw‘.edpha} Road,
Hyderabad-SO‘\ 401.




REPORT FOR GUEST LECTURE

Title of the Workshop: PREPARATION OF CHEMICAL COMPOUNDS
Participants: VII Class Students, ZPHS School, Pudur

Resource Persons:

S.NO ROLL NUMBER STUDENT NAME
1 16H51A05D8 J Ramya

2 16H51A04M6 Mallela Harika

3 15H51A0245 Rajesh Kumar Malineni

4 15SH51A0285 K Tejavardhan Yadav

This guest lecture was aimed to provide basic knowledge of Chemical Compounds and
learn about the preparation of chemical compound aspirin. About 24 students participated in this
guest lecture.

Student of CMR College of Engineering & Technology explained about the equipment
used in Chemistry lab and demonstrated the preparation of Chemical compound aspirin.




OUTCOMES:
At the end of this Awareness lecture students will be able to

e Know about the equipment used in chemistry lab.
e Make the chemical compound Aspirin

Date: 293 %9 ? PR N 1 Dr.J.Srid
Place: ~macE TN " Convener.

‘!‘1{‘1‘;1(:“,‘.‘\‘ ;‘(; .‘;1;( i
CMR COLLECE OF & 1chal Roads
Kand\a"‘o‘fa gﬂ =04 401
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CMR COLLEGE OF ENGINEERING & TECHNOLOGY
(UGC Autonomous)
NAAC Accreditation with A — Grade
Kandlakoya, Hyderabad— 501 401
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LRRLIRE 1 NYER]
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PREPARATION OF CHEMICAL COMPOUNDS

Date: 24-03-2018
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AWARENESS LECTURE ON

PREPARATION OF CHEMICAL COMPOUNDS

Date: 24-03-2018
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CMR CMR COLLEGE OF ENGINEERING & TECHNOLOGY
et (UGC Autonomous)

NAAC Accreditation with A — Grade
Kandlakoya, Hyderabad— 501 401

FEEDBACK FORM

Name of the Presenter: [C\N*da\ \)‘pa-;-., ika, Eo \@ . J,ﬁ\.,{}q Date: '1\11 \E\ 20\ &

Title: _ ADcmerdy  \OCuwe o paoponotr of  abgwicel  Cowgpe d
How would you rate the session. v ‘ :
1. How would you rate the usefulness of the content?
LE R R (ke
f 2. How would you rate the presenters’ style of teaching?
(1 2 3 4./ 5)
3. How would you rate the pace of the presentation?

| (Too fast Too slow J usi right)

4. What did you like best or find useful in the presentation?

OF ENGG. & TECH.

[ /y, Medchal Road,

Fiyu dldd-ou iqul.
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CMR CMR COLLEGE OF ENGINEERING & TECHNOLOGY
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FEEDBACK FORM
Name of the Presenter: [e G Date:Qu|»|ools

Title: dugqmw ig[_‘ﬁgﬁ on pragaﬁfﬂz f}é [E}Qm('gl {Qg}fxgﬂj &f

How would you rate the session.
1. How would you rate the usefulness of the content?
(1 2 3 4 5))/
2. How would you rate the presenters’ style of teaching?
(1 2 3 4 5;/
3. How would you rate the pace of the presentation?
(Too fast Too slow Just nght)

4. What did you like best or find useful in the presentation?
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FEEDBACK FORM
o o e

Name of the Presenter: Date: ,24‘ L -D3-201R

How would you rate the session.

1. How would you rate the usefulness of the content?

&
' R 3 4 5)

)

How would you rate tiypresenters‘ style of teaching?

i 3 4 5)

(o8 ]

How would you rate the pace of t‘}ypresemation‘?
(Too fast Too slow Just right)

4. What did you like best or find useful in the presentation?
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FEEDBACK FORM
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How would you rate the session.
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How would you rate the usefulness of the content?

(1 2 3 + S/)

How would you rate the presenters’ style of teaching?
T e

How would you rate the pace of the presentation?

(Too fast Too slow Just right)

What did you like best or find useful in the presentation?
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How would you rate the session.
1. How would you rate the usefulness of the content?
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2. How would you rate the presenters’ style of teaching?
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3. How would you rate the pace of the presentation?
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i -2 Bl 3

3. How would you rate the pace of the presentation?
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How would you rate the presenters’ style of teaching?
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3. How would you rate the pace of the presentation?
(Too fast Too slow . \fl:Sl right)

4. What did you like best or find useful in the presentation?
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How would you rate the usefulness of the content?
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Date: 27-11-2018,
Pudur.

To

The Principal,
CMRCET,
Hyderabad.

Respected Sir,

Sub: Appreciation for conducting a guest lecture on Preparation of Chemical Compounds for our School

Students- Regarding

With reference to the above-cited subject, I appreciate and be thankful to the students, faculty,
and management of CMRCET for conducting this the guest lecture. With the help of this guest lecture,
our students have gained knowledge about the Preparation of Chemical Compounds. Students have
enjoyed the learning about the preparation of Chemical Compound Aspirin.

Thanking You.

B,
WBGR

Pudur.
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“gﬁg CMR COLLEGE OF ENGINEERING & TECHNOLOGY
CMR (Autonomous)

oRe T s NAAC Accredited Institution with ‘A’ Grade
Kandlakoya (V), Medchal Road, Hyderabad -501401.
CMRCET/PRIN/NaipunyaClub/CIR/2017-18/02 Date: 26/03/2018
Circular

This is to inform that a meeting is scheduled to faculty and student committee members of
Naipunya club on 30™ March 2018 in Room Number 102, Block 1.

o

All the committee members are requested to be present on time.

Agenda of the meeting is mentioned below.
1. To Review the events conducted in the Academic year 2017-18.

2. To discuss on the events which may not be conducted during the Academic year 2017-18

LN

Principal

Copy Submitted to: (1) The Secretary Garu — For your kind information PI.

Copy to:

1. IQAC Coordinator

2. Deans

3. Controller of Examinations

4. AllHODS -

5. Administrative Officer /

6. Accounts Officer ——

7. Librarian

8. Training & Placement CMR COLLEGE OF ENGG. & TRCR.
Kandlakoya (V), Medchal Road,

9. Concerned Faculty through Email Hyderabad-501401.

10. Naipunya Club
11. Students Notice Board



